
SEASOFT - SBE Data Processing
CTD Data Processing Software for
Windows 95/98/NT

User’s Manual
Sea-Bird Electronics, Inc.
1808 136th Place NE
Bellevue, Washington 98005 USA
Tel: 425/643-9866 10/17/00
Fax:425/643-9954 Software Beta Release 1.0



2

Limited Liability Statement

Extreme care should be exercised when using or servicing this equipment. It should be used or serviced
only by personnel with knowledge of and training in the use and maintenance of oceanographic
electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing
of this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment
or of choosing the personnel to operate it, and therefore cannot take steps to comply with laws
pertaining to product liability, including laws which impose a duty to warn the user of any dangers
involved in operating this equipment. Therefore, acceptance of this system by the customer shall be
conclusively deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use or servicing of
this system.
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Section 1: Introduction
This section includes contact information and a brief description
of SEASOFT and its components.

How to Contact Sea-Bird
Sea-Bird Electronics, Inc.
1808 136th Place Northeast
Bellevue, Washington 98005 USA

Telephone: 425-643-9866
Fax: 425-643-9954
E-mail: seabird@seabird.com
Website: http://www.seabird.com

Business hours:
Monday-Friday, 0800 to 1800 Pacific Standard Time

(1600 to 0200 Universal Time)
Except from April to October, when we are on ‘summer time’

(1500 to 0100 Universal Time)

Summary
SEASOFT consists of modular, menu-driven routines for acquisition, display,
processing, and archiving of oceanographic data acquired with Sea-Bird
equipment. SEASOFT is designed to work with a PC running Win 95/98/NT.

The Windows version of SEASOFT is actually several stand-alone programs:
•  SEATERM and SeatermAF terminal programs that send commands to

instrument for status, data acquisition setup, data retrieval, and diagnostics
•  SEASAVE real-time data acquisition program that acquires real-time data
•  SBE Data Processing program that converts, edits, and processes data

The main emphasis of this manual is the SBE Data Processing program.
SEATERM and SeatermAF are briefly covered in Section 4: Terminal
Program Modules. SEASAVE is covered in detail in a separate manual.

Products Supported
The SBE Data Processing program supports the following Sea-Bird products:
•  SBE 911plus CTD system
•  SBE 9plus/17 SEARAM CTD system
•  SBE 16 SEACAT
•  SBE 19 SEACAT Profiler
•  SBE 21 SEACAT Thermosalinograph
•  SBE 25 SEALOGGER CTD
•  SBE 35 Thermometer
•  SBE 37-SM and 37-IM MicroCAT Conductivity and Temperature

(optional pressure) Recorder
•  SBE 39 Temperature (optional pressure) Recorder
•  SBE 48 Hull Temperature Sensor
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Software Modules
SEASOFT includes the following modules:

Type Module Name Module Description
SEATERM Interface with a wide variety of Sea-

Bird instruments.
Terminal
programs
Send commands to
instrument for
status, data
acquisition setup,
data retrieval,
diagnostics. See
Section 4.

SeatermAF Interface with Sea-Bird instruments
that power and operate water samplers
without real-time communication to
the surface
(90208 Auto Fire Module and
SBE 17plus V2 SEARAM).

Instrument
configuration
See Section 5.

CONFIGURE
(equivalent to
SEACON in
DOS version)

Define instrument configuration and
calibration coefficients.

SEASAVE Acquire real-time data, display raw
archived data.

DATA
CONVERSION

Convert raw data (.hex or .dat file) to
engineering units, and store converted
data in .cnv file.

Real-time data
acquisition,
playback,
conversion
See SEASAVE for
Windows Manual
for SEASAVE
details. See
Section 6 for other
modules.

ROSETTE
SUMMARY

Summarize data from rosette (water
sampler bottle) .ros file, storing the
results in .btl file.

ASCII IN Add header information to a .asc file
containing ASCII data.

MARK SCAN Create .bsr bottle scan range file from
.mrk data file.

SPLIT Split data in .cnv file into upcast and
downcast files.

STRIP Extract columns of data from
.cnv file.

SECTION Extract rows of data from .cnv file.

File editing
See Section 7.

TRANSLATE Convert data format in .cnv file from
ASCII to binary, or vice versa.

ALIGN CTD Align data relative to pressure
(typically used for conductivity,
temperature, and oxygen).

BIN
AVERAGE

Average data, basing bins on pressure,
depth, scan number, or time range.

BUOYANCY Compute Brunt Väisälä buoyancy and
stability frequency.

CELL
THERMAL
MASS

Perform conductivity thermal
mass correction.

DERIVE Calculate salinity, density, sound
velocity, oxygen, potential
temperature, dynamic height, etc.

FILTER Low-pass filter columns of data.
LOOP EDIT Mark a scan with badflag if scan

fails pressure reversal or minimum
velocity tests.

WILD EDIT Mark a data value with badflag to
eliminate wild points.

Data processing
Performed on
converted data
from a .cnv file.
See Section 8.

WINDOW
FILTER

Filter data with triangle, cosine,
boxcar, gaussian, or median window.

Notes:
1. The following modules are stand-

alone Win 95/98/NT programs,
not included in SBE Data
Processing:
•  SEATERM terminal program
•  SeatermAF terminal program
•  SEASAVE real-time data

acquisition program
2. The following modules from DOS

SEASOFT are not yet available in
the Win 95/98/NT version of
SBE Data Processing:
•  CONTOUR
•  SEAPLOT
•  OXFIT
•  OXFITW
•  OXSAT
•  PHFIT
•  SEACALC



                                                                                            Section 1: Introduction                                                                                            

7

(continued)
Type Module Name Module Description

ASCII OUT Output data portion and/or header
portion from .cnv file to an ASCII
file (.asc for data, .hdr for header).
Useful for exporting converted data
for processing by other software.

CONTOUR Generate density contours to overlay
on TS plots.

Data display and
plotting
Performed on
converted data
from a .cnv file.
See Section 9 for
ASCII OUT. See
DOS SEASOFT
manual for
CONTOUR and
SEAPLOT - these
modules are not yet
available in
Windows version.

SEAPLOT Plot data (C, T, P as well as derived
variables). Plots can be screen
dumped to a printer or plotted on an
HP pen plotter or HP LaserJet III.
Note that SEAPLOT can plot data at
any point after DATA
CONVERSION has been run.

OXFIT Compute oxygen coefficients.
OXFITW Compute oxygen coefficients using

Winkler titration values.
OXSAT Compute oxygen saturation as a

function of temperature and salinity.

Calibration
See DOS
SEASOFT manual
- these modules are
not yet available in
Windows version. PHFIT Compute pH coefficients.
Miscellaneous
See DOS
SEASOFT manual
- this module is not
yet available in
Windows version.

SEACALC Calculate derived variables.

Differences from DOS SEASOFT
SEASOFT was previously available in a DOS version (referred to in this
document as DOS SEASOFT). Following are the differences between this
Windows version and DOS SEASOFT:

1. The Windows version of SBE Data Processing does not include the
following modules that are available in DOS SEASOFT:
•  Terminal Programs - Windows-based terminal programs SEATERM

and SeatermAF were released in early 2000, to replace the terminal
programs in DOS SEASOFT (TERM1621, TERM17, TERM19,
TERM25, TERM37, TERMAFM, TERM11, and TMODEM).
SEATERM and SeatermAF are stand-alone programs that are not
accessed from within SBE Data Processing.

•  SEASAVE - Windows-based SEASAVE was released in 1998, to
replace SEASAVE in DOS SEASOFT. SEASAVE is a stand-alone
program that is not accessed from within SBE Data Processing.

•  Data Display Modules - CONTOUR and SEAPLOT have not yet
been added to SBE Data Processing.

•  Calibration Modules - OXSAT, OXFIT, OXFITW, and PHFIT have
not yet been added to SBE Data Processing.

•  Miscellaneous Modules - SEACALC has not yet been added to
SBE Data Processing.

2. The SBE 9plus (with SBE 11plus Deck Unit or SBE 17 SEARAM) is the
only version of the SBE 9 that is supported in SBE Data Processing.
Sea-Bird has been manufacturing the SBE 9plus since 1991.

3. The SBE 31 is not supported in SBE Data Processing.
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Section 2: SBE Data Processing
Installation and Use

SBE Data Processing requires approximately 40 Mbytes of disk space during
installation. Ensure there is room on your hard drive before proceeding.

SBE Data Processing Installation

1. If not already installed, install SBE Data Processing and other Sea-Bird
software programs on your computer using the supplied software CD:
A. Insert the CD in your CD drive.
B. Double click on Setup.exe.
C. Follow the dialog box directions to install the software.
The default location for the software is c:/Program Files/Sea-Bird. Within
that folder is a sub-directory for each program.

Note:
Sea-Bird supplies the current version
of our software when you purchase
an instrument. As software revisions
occur, we post the revised software
on our FTP site.
•  You may not need the latest

version. Our revisions often include
improvements and new features
related to one instrument, which
may have little or no impact on
your operation.

See our website (www.seabird.com)
for the latest software version
number, a description of the software
changes, and instructions for
downloading the software from the
FTP site.
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SBE Data Processing Use
SBE Data Processing Window
Start the SBE Data Processing program by:
•  Double clicking on SBEDataProc.exe

(default location c:/Program Files/Sea-Bird/DataProcessing-Win32), or
•  (for Windows 98) Left clicking on Start and following the path

Programs/Sea-Bird/DataProcessing

The SBE Data Processing window looks like this:

The window’s menus and button are described below.

Menus
•  Run - contains a list of the post-processing modules. Select the desired

module to set up the module parameters and process data. Module Dialog
Box in this section provides an overview of the post-processing module
dialog box; Sections 6 through 9 provide the details for each module.

•  Configure - contains a list of Sea-Bird instruments that require a
configuration (.con) file. Select the desired instrument to modify or create
a .con file for that instrument. The .con file defines the number and type
of sensors interfacing with the instrument, as well as the sensor calibration
coefficients. See Section 5: Configuring the Instrument for details.

•  Help - contains general program help files as well as context-specific help.

Run Options Button (for running a post-processing module)
Run options can be used to assist in automating processing.
See Appendix I: Run Options, Command Line Operation, and Batch File
Processing for details.

Note:
SBE Data Processing modules can
be run from the command line. Also,
batch file processing can be used to
process a batch file to automate data
processing tasks. See Appendix I:
Run Options, Command Line
Operation, and Batch File Processing
for details.
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Module Dialog Box
To open a post-processing module, select it in the Run menu of the SBE Data
Processing window. Each module’s dialog box has three menus:
•  File -

! Start Process - begin to process data as defined in dialog box
! Open - select a different program setup (.psu) file
! Save or Save As - save all current settings to a .psu file
! Restore - reset all settings to match last saved .psu file
! Default File Setup - reset all settings on File Setup tab to defaults
! Default Data Setup - reset all settings on Data Setup tab to defaults
! Exit or Save & Exit - exit module and return to SBE Data

Processing window
•  Options (where applicable) -

! Confirm Program Setup Change - If selected, program provides a
prompt to save the program setup (.psu) file if you make changes and
click the Exit button or select Exit in the File menu without clicking
or selecting Save or Save As. If not selected, program changes
Exit to Save & Exit; to exit without saving changes, use the
Cancel button.

! Confirm Instrument Configuration Change - If selected, program
provides a prompt to save the configuration (.con) file if you make
changes and then click the Exit button in the Configuration dialog
box without clicking Save or Save As. If not selected, program
changes Exit button to Save & Exit; to exit without saving
changes, use the Cancel button.

! Overwrite Output File Warning - If selected, program provides a
warning if output data will overwrite an existing file. If not selected,
program automatically overwrites an existing file with the same
file name as the output file.

! Inconsistent Output Variables Warning - If selected, program
provides a warning if changes made to the configuration (.con) file
make it inconsistent with the selected output variables. For example,
if the output variables include conductivity difference, but you
remove the second conductivity sensor from the .con file, a warning
will appear. The warning details what output variable cannot be
calculated, and allows you to retain the change to the .con file (and
remove the inconsistent output variable) or restore the .con file to the
previous configuration. If not selected, program does not provide
a warning.

•  Help - contains general program help files as well as context-specific help
(where applicable)

Each module’s dialog box typically has three tabs - File Setup, Data Setup,
and Header View. The File Setup and Header View tabs are similar for all the
modules, and are discussed below. The Data Setup tab contains input
parameters specific to the module - see the module discussions in Sections 6
through 9 for details.
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The following examples and discussion of the File Setup and Header View
tabs is for DATA CONVERSION. The other modules are similar; however,
not all fields are applicable to all modules.

File Setup Tab

File to store all information input in File Setup and Data Setup tabs. Open to
select a different .psu file, Save or Save As to save current settings, or Restore
to reset all settings to match last saved version.
As a default, .psu file is stored in same directory as SBEDataProc.exe (default is
c:/Program Files/Sea-Bird/SeasoftPostProcessingExes). PostProcSuite.ini,
located in Windows directory, contains location and file name of last saved .psu
file and options settings for each module.

Input instrument
configuration file (.con)
location. This file controls
what data is available in
the Data Setup tab. Select
to pick a different file, or
Modify to view and/or
modify instrument
configuration.

Select if more than 1 data file is to be
processed, and data files have different
configuration (.con) files. For example, if
processing test.dat and test1.dat, and this
option is selected, program will search for
test1.con (in same directory as test.con) to
process test1.dat.

Directory and file names
for input data. Select to
pick a different file. To
process multiple data files
from same directory:
1. Click Select.
2. In Select dialog box,

hold down Ctrl key
while clicking on each
desired file.

If multiple files are
selected, header in each
file must contain same set
of sensors and variables.

Directory and file names for output data.
•  If more than 1 data file is to be processed, Output file field disappears

and output file name is set to match input file name. For example,
if processing test.dat and test1.dat, output files will be test.cnv
and test1.cnv.

•  SBE Data Processing adds Name append to (each) output file name,
before extension. For example, if processing test.dat and test1.dat
with a Name append of datcnv, output files will be testdatcnv.cnv and
test1datcnv.cnv. Use Name append to save intermediate data files
when input and output files have same extension.

Click Start Process to
begin processing data.
Status field shows
Processing complete
when done.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in

Options menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

•  If Confirm Program Setup Change was not selected
in Options menu - This button says Save & Exit.
If you do not want to save changes, use Cancel
button to exit.
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Header View Tab

View existing header in input file(s). If
multiple input files are to be processed,
switch between input file headers by
using Prior and Next buttons.

•  Header lines beginning with * contain header
information copied from raw input data file.

•  Header lines beginning with # contain header
information describing input converted data (.cnv) file
(not applicable to example shown). As each module is
run, it adds information to the header, such as the input
file name for the module, date and time the module
was run, and input parameters. Thus, the header
contains a complete record of how the data has been
converted, edited, and manipulated.

•  ASCII string *END* flags end of header information.
Begin processing data.
Status field on File Setup tab
shows Processing complete
when done.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu -

If you made changes in the File Setup or Data Setup tab and did not
Save or Save As, program asks if you want to save changes.

•  If Confirm Program Setup Change was not selected in Options menu -
This button says Save & Exit. If you do not want to save changes made
on the File Setup or Data Setup tab, use Cancel button to exit.
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File Formats
File extensions are used by SEASOFT to indicate the file type:
EXTENSION DESCRIPTION
.asc Data portion of .cnv converted data file written in ASCII by

ASCII OUT, or
Files written by SEATERM for an SBE 37-IM, 37-SM, or 39.
(Note: Convert button on SEATERM’s toolbar can convert .asc file
to .cnv file that can be used by SBE Data Processing to process data.)

.bl Bottle sequence number, position, date, time, and beginning and
ending scan numbers, created by SEASAVE when a bottle fire
confirmation is received.

.bsr Bottle scan range file created by MARK SCAN, and used by DATA
CONVERSION to create a .ros file.

.btl Averaged and derived bottle data from a .ros file, created by
ROSETTE SUMMARY.

.cnv Converted (engineering units) data file, with an ASCII header
preceding data. Created by DATA CONVERSION, or by
SEATERM’s Convert button (SE 37-IM, 37-SM, or 39 only).

.con Instrument configuration (number and type of sensors) and
calibration coefficients. Created in CONFIGURE; used (and can be
modified) in SEASAVE, DATA CONVERSION, DERIVE, and
ROSETTE SUMMARY.

.ctr Density contour file generated by CONTOUR.

.dat Raw binary data, optionally with header information, for
SBE 911plus, and data files created with previous versions
of SEASOFT.

.dsp Data acquisition and display parameters, stored by SEASAVE.

.hdr Header portion of a .cnv converted data file written by ASCII OUT,
or
Header recorded when acquiring real-time data or uploading
archived data.

.hex Raw HEX data with header information, for SBE 16,
17plus (used with 9plus), 19, 21, and 25.

.mrk Marker file created by SEASAVE during real-time data acquisition to
indicate bottle closures.

.plt Display parameters stored by SEAPLOT.

.psu File containing input file name and data path, output data path, and
module-specific parameters used by SBE Data Processing modules.

.ros File containing data for each scan associated with a bottle closure, as
well as data for a user-selected range of scans before and after each
closure; created by DATA CONVERSION.

Converted Data File (.cnv) Format
Converted files consist of a descriptive header followed by converted data in
engineering units.

The header contains:
1. Header information from the raw input data file (these lines begin with *)
2. Header information describing the converted data file (these lines begin

with #). The descriptions include:
•  number of rows and columns of data
•  variable for each column (for example, pressure, temperature, etc.)
•  interval between each row (scan rate or bin size)
•  historical record of processing steps that were used to create or

modify file
3. ASCII string *END to flag the end of the header information

The converted data is stored in either rows and columns of ASCII numbers
(11 characters per value) or as a binary data stream with each value stored as a
4 byte binary floating point number. The last data column is a flag field used
to mark scans as bad in LOOP EDIT.
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Section 3:
Typical Data Processing Sequences

Following are typical data processing sequences for each instrument.
These sequences (and any values given for aligning and filtering data) are
based on a typical situation with a boat at low latitude lowering an instrument
at 1 meter/second.

These examples assume that a configuration (.con) file is available for the
instrument. Note that a .con file is provided by Sea-Bird when the instrument
is purchased, based on the user-specified configuration and the factory-
calibration. An existing .con file can be modified while in SEASAVE or in the
DATA CONVERSION, DERIVE, or ROSETTE SUMMARY module,
if desired. If you do not have a .con file for the instrument, first run
CONFIGURE from SBE Data Processing’s Configure menu to create the
.con file.

M

T

Notes:
1. SEAPLOT can display data at any

point after DATA CONVERSION has
been run.

2. Use ASCII OUT to export
converted data (without header) to
other software.

3. Oxygen values computed by
SEASAVE and DATA
CONVERSION differ from values
computed by DERIVE. Both
algorithms use the derivative of
oxygen current with respect to
time (doc/dt):
•  Quick estimate - SEASAVE and

DATA CONVERSION compute
doc/dt looking back in time,
because SEASAVE cannot use
future values while acquiring real-
time data.

•  Most accurate results - DERIVE
uses a centered window (equal
number of points before and after
scan) to compute doc/dt.
14

inimum Processing of Data
Program / Module Function
1. SEASAVE,

SEATERM, or
SeatermAF

Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity

(dependent on instrument options selected)
•  (if auxiliary sensors are part of system) oxygen

concentration, light transmission, etc.
•  (if applicable) derived parameters such as

salinity, density, and sound velocity

ypical Processing of SBE 16 and 21 Data
Program / Module Function
1. SEASAVE or

SEATERM
Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity

(dependent on instrument options selected)
•  (if auxiliary sensors are part of system) oxygen

concentration, light transmission, etc.
•  (if applicable) derived parameters such as

salinity, density, and sound velocity
3. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 19 Data
Pumped SBE 19

Without Oxygen Sensor
Program / Module Function
1. SEASAVE or

SEATERM
Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  (if auxiliary sensors are part of system) light

transmission, pH, fluorescence, etc.
3. FILTER •  Low-pass filter conductivity with a time constant

of approximately 0.5 seconds to force
conductivity to have same response as
temperature.

•  Low-pass filter pressure with a time constant of
2 seconds to increase pressure resolution for
LOOP EDIT.

4. ALIGN CTD Advance temperature relative to pressure
approximately +0.5 seconds.

5. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. BIN AVERAGE Average data into desired pressure or depth bins.
7. DERIVE Compute salinity, density, and other parameters.

With Oxygen Sensor
Program / Module Function
1. SEASAVE or

SEATERM
Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  dissolved oxygen current and dissolved oxygen

temperature
•  (if other auxiliary sensors are part of system)

light transmission, etc.
3. FILTER •  Low-pass filter conductivity with a time constant

of approximately 0.5 seconds to force
conductivity to have same response as
temperature.

•  Low-pass filter pressure with a time constant of
2 seconds to increase pressure resolution for
LOOP EDIT.

4. ALIGN CTD •  Advance temperature relative to pressure
approximately +0.5 seconds.

•  Advance oxygen relative to pressure
approximately +3 to +7 seconds. Note that this
value depends on oxygen sensor response time.

5. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. DERIVE Compute oxygen from oxygen current, oxygen
temperature, temperature, and pressure.

7. BIN AVERAGE Average data into desired pressure or depth bins.
8. DERIVE Compute salinity, density, and other parameters.
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Unpumped SBE 19

Without Oxygen Sensor
Program / Module Function
1. SEASAVE or

SEATERM
Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  (if auxiliary sensors are part of system) light

transmission, pH, fluorescence, etc.
3. FILTER •  Low-pass filter conductivity with a time constant

of approximately 0.5 seconds, to force
conductivity to have same response as
temperature.

•  Low-pass filter pressure with a time constant of
2 seconds to increase pressure resolution for
LOOP EDIT.

4. ALIGN CTD Advance temperature relative to pressure
approximately +0.5 seconds. Note that this value
depends on descent rate of CTD through water.

5. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. BIN AVERAGE Average data into desired pressure or depth bins.
7. DERIVE Compute salinity, density, and other parameters.

With Oxygen Sensor
Program / Module Function
1. SEASAVE or

SEATERM
Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  dissolved oxygen current and dissolved oxygen

temperature
•  (if other auxiliary sensors are part of system)

light transmission, etc.
3. FILTER •  Low-pass filter conductivity with a time constant

of approximately 0.5 seconds to force
conductivity to have same response as
temperature.

•  Low-pass filter pressure with a time constant of
2 seconds to increase pressure resolution for
LOOP EDIT.

4. ALIGN CTD •  Advance temperature relative to pressure
approximately +0.5 seconds.

•  Advance oxygen relative to pressure
approximately +1 to +5 seconds.

Note that these values depend on descent rate of CTD
through water and oxygen sensor response time.

5. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. DERIVE Compute oxygen from oxygen current, oxygen
temperature, temperature, and pressure.

7. BIN AVERAGE Average data into desired pressure or depth bins.
8. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 25 Data
Pumped, Without Oxygen Sensor

Program / Module Function
1. SEASAVE or

SEATERM
Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  (if auxiliary sensors are part of system) light

transmission, pH, fluorescence, etc.
3. FILTER Low-pass filter pressure with a time constant of

0.5 seconds to increase pressure resolution for
LOOP EDIT.

4. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

5. BIN AVERAGE Average data into desired pressure or depth bins.
6. DERIVE Compute salinity, density, and other parameters.

Pumped, With Oxygen Sensor

Program / Module Function
1. SEASAVE or

SEATERM
Acquire raw data.

2. DATA
CONVERSION

Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  dissolved oxygen current and dissolved oxygen

temperature
•  (if other auxiliary sensors are part of system)

light transmission, etc.
3. ALIGN CTD Advance oxygen relative to pressure approximately

+3 to +7 seconds. Note that this value depends on
descent rate and oxygen sensor response time.

4. FILTER Low-pass filter pressure with a time constant of
0.5 seconds to increase pressure resolution for
LOOP EDIT.

5. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. DERIVE Compute oxygen from oxygen current, oxygen
temperature, temperature, and pressure.

7. BIN AVERAGE Average data into desired pressure or depth bins.
8. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 911plus Data

Pumped, Without Oxygen Sensor

Program / Module Function
1. SEASAVE Acquire raw data.
2. DATA

CONVERSION
Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  (if auxiliary sensors are part of system) light

transmission, pH, fluorescence, etc.
3. CELL

THERMAL
MASS

Perform conductivity cell thermal mass correction if
salinity accuracies of better than 0.01 PSU in regions
with steep gradients are desired. Typical values are
alpha = 0.03 and 1/beta = 7.0.

4. FILTER Low-pass filter pressure with a time constant of
0.15 seconds to increase pressure resolution for
LOOP EDIT.

5. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. BIN AVERAGE Average data into desired pressure or depth bins.
7. DERIVE Compute salinity, density, and other parameters.

Pumped, With Oxygen Sensor

Program / Module Function
1. SEASAVE Acquire raw data.
2. DATA

CONVERSION
Convert raw data, selecting ASCII as data conversion
format. Converted data includes:
•  pressure, temperature, and conductivity
•  dissolved oxygen current and dissolved oxygen

temperature
•  (if other auxiliary sensors are part of system)

light transmission, etc.
3. ALIGN CTD Advance oxygen relative to pressure approximately

+2 to +5 seconds. Note that this value depends on
oxygen sensor response time.

4. CELL
THERMAL
MASS

Perform conductivity cell thermal mass correction if
salinity accuracies of better than 0.01 PSU in regions
with steep gradients are desired. Typical values are
alpha = 0.03 and 1/beta = 7.0.

5. FILTER Low-pass filter pressure with a time constant of
0.15 seconds to increase pressure resolution for
LOOP EDIT.

6. LOOP EDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

7. DERIVE Compute oxygen from oxygen current, oxygen
temperature, temperature, and pressure.

8. BIN AVERAGE Average data into desired pressure or depth bins.
9. DERIVE Compute salinity, density, and other parameters.

Notes:
1. These examples assume the

SBE 11plus Deck Unit has been
set to correctly advance
conductivity relative to pressure
(1.75 scans, 0.073 seconds) for
911plus systems with a TC Duct.
If desired, use ALIGN CTD to
verify this by adding positive and
negative advances to
conductivity and observing the
effect on salinity and density
computed by DERIVE.

2. FILTER can be run before CELL
THERMAL MASS to remove any
residual response time between
the temperature and conductivity
sensors and to minimize
digitization noise. Typically, a
low-pass filter with 0.03 second
time constant slightly reduces the
noise in computed salinity. A low-
pass filter with a time constant
can be used to smooth the
pressure data, particularly when
examining full rate (24Hz) fine
structure data on pressure scales
of 10 meters (33 ft) or less.
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Typical Processing of SBE 37-SM, 37-IM, and 39 Data
Program / Module Function
1. SEATERM and

Convert button
on SEATERM
toolbar

Upload data (in engineering units) in ASCII (.asc)
format. Use Convert button to convert .asc file to
.cnv file, which can be used by SBE Data Processing
modules.

2. DERIVE As applicable, compute salinity, density, and other
parameters.
Note: An SBE 37-SM, 37-IM, and 39 stores
calibration coefficients internally, and does not have a
.con file. However, DERIVE requires you to select a
.con file before it will process data. Select any .con
file (or create and select an empty file with a .con
extension) - the contents of the file will not affect the
results for these instruments.
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Section 4: Terminal Program Modules
Terminal programs send commands to instruments to provide status, data
acquisition setup, data retrieval, and diagnostic tests.

Module Name Module Description
SEATERM For a wide variety of instruments:

•  SBE 11 CTD Deck Unit
•  SBE 16 SEACAT
•  SBE 17 SEARAM
•  SBE 19 SEACAT Profiler
•  SBE 21 SEACAT Thermosalinograph
•  SBE 25 SEALOGGER CTD
•  SBE 35 Thermometer
•  SBE 37 MicroCAT
•  SBE 38 Digital Oceanographic Thermometer
•  SBE 39 Temperature (optional pressure) Recorder
•  SBE 44 Underwater Inductive Modem
•  SBE 45 Thermosalinograph
•  SBE 48 Hull Temperature Sensor

SeatermAF For instruments that power and operate water samplers
without real-time communication to the surface:
•  SBE 17plus V2 SEARAM
•  SBE 90208 Carousel Auto Fire Module

(used independently or with SBE 19 or 25)

Note:
See the instrument User
Manual or the Terminal
Program module’s Help files for
specific communication settings
and commands.
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General Description
Double click on the SEATERM icon. SEATERM’s main screen looks like this
(SeatermAF is similar):

•  Menus – Contains tasks and frequently executed instrument commands.
•  Toolbar – Contains buttons for frequently executed tasks and instrument

commands. All tasks and commands accessed through the Toolbar are
also available in the Menus. To display or hide the Toolbar, select View
Toolbar in the View menu.

•  Command/Data Echo Area – Echoes a command executed using a Menu
or Toolbar button, as well as the instrument’s response. Additionally, a
command can be manually typed in this area, from the available
commands for the instrument. Note that the instrument must be awake for
it to respond to a command (use the Connect button on the Toolbar to
wake up the instrument).

•  Status bar – Provides status information. To display or hide the Status bar,
select View Status Bar in the View menu.

Note that Menus and Toolbar buttons that are not applicable to the selected
instrument are grayed out and cannot be selected.

Note:
There is at least one, and as many
as three ways, to enter a command:
•  Manually type command in

Command/Data Echo Area
•  Use a menu to automatically

generate a command
•  Use a Toolbar button to

automatically generate
a command

Note:
Once the system is configured and
connected (see Getting Started
below), to update the Status bar:
•  on the Toolbar, click Status; or
•  from the Utilities menu, select

Instrument Status.
The program sends the status
command, which displays in the
Command/Data Echo Area, and
updates the Status bar.

Status bar

Menus

Command/Data Echo Area

Toolbar

Instrument
Computer
COM port

Instrument EPROM version Baud rate, data bits, stop bits, and parity

Capture to file status –
grayed out if not capturing

Upload
type
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Getting Started
Follow these steps to get started using SEATERM (SeatermAF is similar) with
your instrument:

1. In the Configure menu, select the instrument. Enter the COM settings for
your instrument in the Configuration Options dialog box.

Click OK to overwrite an existing configuration file, or click Save As to
save the configuration as a new file name.

2. Click the Connect button on the Toolbar. The system should respond with
a dialog box stating ‘Connected successfully . . .’ and an S> prompt. If it
does not:
•  Try to establish communications again.
•  Check cabling between the computer and instrument.
•  Verify the correct instrument was selected and the COM Settings

were entered correctly in the Configure Menu.

3. Enter commands using one of these methods:
•  Manually type in the command in the Command/Data Echo Area,
•  Use a menu to automatically generate a command (applicable to

frequently used commands), or
•  Use a toolbar button to automatically generate a command (applicable

to frequently used commands).

Note:
All Sea-Bird instruments have a
timeout feature. After a period of
time without communication, the
instrument and computer
disconnect, the instrument enters
a quiescent (sleep) state, and the
command/data echo area
indicates time out. You must
reconnect to the instrument
before sending any commands.

Computer COM port, baud rate,
data bits, and parity for
communication between computer
and instrument

Interface for communication
between computer and
instrument

Not applicable if
Mode is RS-232.
•  Prompt ID

if multiple
instruments
on-line.

•  Automatically
get ID if
1 instrument
on-line.

Instrument EPROM version – may
affect available upload baud rate
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SEATERM
SEATERM is used to interface with the following instruments:
•  SBE 11 CTD Deck Unit
•  SBE 16 SEACAT
•  SBE 17 SEARAM
•  SBE 19 SEACAT Profiler
•  SBE 21 SEACAT Thermosalinograph
•  SBE 25 SEALOGGER CTD
•  SBE 35 Thermometer
•  SBE 37 MicroCAT
•  SBE 39 Temperature (optional Recorder
•  SBE 45 MicroTSG Thermosalinograph
•  SBE 48 Hull Temperature Sensor

Following is a brief discussion of the Toolbar Key functions.

Toolbar
Keys

Description Equivalent
Command *

Connect Re-establish communications with instrument. Computer
responds with S> prompt.

(press Enter
key)

Status Display instrument status. DS
Headers View data headers. New data header is generated for:

•  each cast for profiling instruments –SBE 17,
19 (profiling mode), and 25

•  each data block in moored instruments – SBE 16, 19
(moored mode), and 21. New header is written when
logging starts/resumes, sample interval changes, or
specified number of samples have been recorded since
last header was written.

DH

Coeff Display calibration coefficients for products with internally
stored coefficients – SBE 35, 37, 39, 45, and 48.

DC

Init Log Initialize data logging for SBE 16, 17, 19, 21, and 25, to
reset data pointers and cast number. Do this after existing
data has been uploaded from instrument and prior to
recording new data.

IL

Capture Capture all information received by computer serial port to
file, to collect real-time data/diagnostic information. File
has .CAP extension. Press Capture again to turn off capture.
Capture status displays in Status bar. For instruments with
no internal memory (SBE 37-SI or 45), must capture
before sampling begins to save the data for future
review and processing.

—

Upload Retrieve data stored in instrument’s memory. Note that you
must stop logging before uploading data.

DD or DC

Convert Convert uploaded ASCII data from SBE 37-IM or
37-SM to .cnv file format before processing data with
SBE Data Processing. Soon to be available for SBE 39 -
use CNV39 in DOS SEASOFT if Convert button is grayed
out for SBE 39.

—

Diagnostics Perform one or more diagnostic tests on instrument.
Diagnostic test(s) accessed in this manner are non-
destructive – they do not write over existing instrument
settings or data.

(dependent
on
instrument)

Stop Interrupt and end current activity, such as: logging,
uploading, or diagnostic testing.

—

Disconnect Disconnecting frees computer COM port used to
communicate with instrument. COM port can then be used
by another program. Any logging in progress will continue
after COM port is disconnected if instrument has
internal memory. Instruments with no internal memory
(SBE 37-SI or 45) must be connected to COM port for
data to be obtained.

—

*See command descriptions in instrument User’s Manual.
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SeatermAF
SeatermAF is used to interface with instruments that power and operate
water samplers without real-time communication to the surface:
•  SBE 17plus V2 SEARAM
•  SBE 90208 Carousel Auto Fire Module (AFM)

Following is a brief discussion of the Toolbar Key functions.

Toolbar
Keys

Description Equivalent
Command  *

Connect Re-establish communications with instrument.
Computer responds with S> prompt (or A> prompt if
connecting to AFM).

(press Enter key)

Status Display instrument status - provide information on
instrument setup and current status.

DS

Headers View data headers (cast number, date and time,
number of samples in cast, and sample interval).
A new header is generated for each cast (applicable
to SBE 17plus V2, 19, and 25)

DH

AFM Display auto fire parameters and auto fire status
(applicable to SBE 17plus V2 and AFM)

CP

Init Log Initialize data logging for SBE 17plus V2, 19, and
25, to reset data pointers and cast number. Do this
after existing data has been uploaded from
instrument and prior to recording new data.

IL  (19 and 25)

SAMPLENUM=0
(17plus V2)

Capture Capture all information received by computer serial
port to file, to collect real-time data/diagnostic
information. File has .cap extension. Press Capture
again to turn off capture. Capture status displays in
Status bar.

—

Upload Retrieve data stored in instrument’s memory. Note
that you must stop logging before uploading data.

(dependent on
instrument)

Program Send auto fire information input in Configure menu
to instrument. Must send this information before
deployment for auto fire capability to function.

 -

Arm Enable auto fire algorithm to close bottles. Must arm
instrument before deployment for auto fire capability
to function.

ARM

Diag Perform one or more diagnostic tests on instrument.
Diagnostic tests accessed in this manner are non-
destructive - they do not write over any existing
instrument settings.

(dependent on
instrument)

Stop Interrupt and end current activity, such as: logging,
uploading, or diagnostic testing.

—

Disconnect Free computer COM port used to communicate with
instrument. COM port can then be used by another
program. Any logging in progress will continue after
COM port is disconnected.

—
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Section 5: Configuring the Instrument
Module Name Module Description
CONFIGURE
(equivalent to
SEACON in
DOS SEASOFT)

Define instrument configuration and calibration
coefficients.

CONFIGURE
CONFIGURE creates or modifies a configuration (.con) file to define the
instrument configuration and sensor calibration coefficients. CONFIGURE is
applicable to the following instruments:
•  SBE 9plus with SBE 11plus Deck Unit or SBE 17plus SEARAM
•  SBE 16
•  SBE 19
•  SBE 21
•  SBE 25

The discussion of CONFIGURE is in three parts:
•  Instrument Configuration covers the Configuration dialog box - number

and type of sensors on the instrument, etc. - for each of the instruments
listed above.

•  Calibration Coefficients for Frequency Sensors covers calculation of
coefficients for each type of frequency sensor (temperature, conductivity,
Digiquartz pressure, IOW sound velocity, etc.).

•  Calibration Coefficients for Voltage Sensors covers calculation of
coefficients for each type of voltage sensor (strain gauge pressure,
oxygen, pH, etc.).

Access CONFIGURE by selecting the desired instrument in the Configure
menu in the SBE Data Processing window.
•  Before selecting the instrument, review the status of Confirm

Configuration Change in the Configure menu. If Confirm Configuration
Change is selected, program provides a prompt to save the configuration
(.con) file if you make changes and then click the Exit button in the
Configuration dialog box without clicking Save or Save As. If not
selected, program changes Exit button to Save & Exit; to exit without
saving changes, use the Cancel button.

Notes:
1. Sea-Bird supplies a .con file with

each instrument. The .con file
must match the existing
instrument configuration and
contain current sensor
calibration information.

2. An existing .con file can be
modified in CONFIGURE, or in
the DATA CONVERSION,
DERIVE, or ROSETTE
SUMMARY post-processing
module.

3. Appendix II: Configure (.con) File
Format contains a line-by-line
description of the contents of the
.con file.

4. An SBE 35, 37, 39, and 48 stores
calibration coefficients internally,
and does not have a .con file.
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Instrument Configuration

SBE 9plus Instrument Configuration
The SBE 9plus is configured for twelve 24-bit words of data sampled at
24 scans per second. The pressure sensor is a high-resolution Paroscientific
digiquartz with temperature compensation. An optional full-duplex modem
channel permits independent control of a water sampler or other instruments.
Firmware in the SBE 11 Deck Unit permits the suppression of unused
data channels.

Channel/Sensor table reflects
this choice.
•  0 (SBE 3 or 4 plugged into

COND 2 on SBE 9 end cap – dual
redundant sensor configuration)

•  1 (SBE 3 or 4 plugged into
TEMP 2 on SBE 9 end cap and
not using COND 2 connector –
single redundant sensor
configuration)

•  2 (no redundant T or C sensors)

For full rate data, set to 1.
Example: CTD scan rate 24 Hz and
number of scans to average 24,
effective scan rate = 24/24 =
1 scan/second.

•  Surface PAR - Select if SBE 11
has surface PAR option installed
and SBE 11 microprocessor PCB
DIP switch S3 position 8 is set to
Off. Selecting Surface PAR
voltage adds 2 channels to
Channel/Sensor table.

•  NMEA - Select if NMEA interface
option installed in SBE 11 and
connected to NMEA interface. If
selected, SEASAVE automatically
adds current latitude, longitude,
and universal time code to data
header. Select NMEA (Lat/Lon)
Interface in SEASAVE’s Configure
menu to control how Lat/Lon data
is incorporated.

Select to include time of each scan with data.

Click a (non-shaded) sensor and click Select
different sensor for that channel. A dialog box
sensors appears. Select sensors after numbe
channels and voltage words have been speci

Opens a .txt file (for viewing
and printing only; cannot be
modified) that shows all
parameters in .con file.

Return to SBE Data Processing window.
•  If Confirm Configuration Change was selected 

Configure menu - If you made changes and did
not Save or Save As, program asks if you wan
save changes.

•  If Confirm Configuration Change was not selec
in Configure menu - This button says Save & E
If you do not want to save changes, use Cance
button to exit.

IEEE-488 (GPIB) or RS-232C, based on
how SBE 11 is connected to computer.

Channel/Sensor table reflects this choice.
Total number of voltage words is 4, and each
word contains data from two 12-bit A/D
channels. SBE 11 suppresses words starting
with highest numbered word. Number of words
to keep is determined by highest numbered
external voltage input that is not a spare:
Words to suppress  = 4 - Words to Keep

External Voltage Connector Words to Keep
(not spare)
0 or 1 AUX 1 1
2 or 3 AUX 2 2
4 or 5 AUX 3 3
6 or 7 AUX 4 4
Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.
 to pick a
 with a list of
r of frequency
fied above.

Click a sensor and click
Modify to change calibration
coefficients for that sensor.

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.

in

t to

ted
xit.
l
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SBE 16 SEACAT Instrument Configuration

Time between scans.

NMEA - Select if connected to
optional NMEA interface (SBE 90158
NMEA nterface box with GPS or
LORAN receiver). If selected,
SEASAVE automatically adds current
latitude, longitude, and universal time
code to data header. Select NMEA
(Lat/Lon) Interface in SEASAVE’s
Configure menu to control how
Lat/Lon data is incorporated.

Select strain gauge, Digiquartz with or
without temperature compensation, or no
pressure sensor. If no pressure sensor or
Digiquartz without Temp Comp is selected,
the Data button accesses a dialog box to
input additional parameter(s) needed to
process data.

Click a (non-shaded) sensor and click Select
to pick a different sensor for that channel. A
dialog box with a list of sensors appears.
Select sensors after number of voltage
channels have been specified above.

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

Channel/Sensor table reflects this
choice (0, 1, 2, 3, or 4). Must agree
with number programmed into SBE 16;
see configuration sheet or reply from
status command (DS).

Return to SBE Data Processing window.
•  If Confirm Configuration Change was selected in

Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

•  If Confirm Configuration Change was not selected
in Configure menu - This button says Save & Exit.
If you do not want to save changes, use Cancel
button to exit.
See SBE 16 configuration sheet
or reply from status command
(DS). Used to determine
strain gauge pressure sensor
data format.
Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.
Click a sensor
and click Modify
to change
calibration
coefficients for
that sensor.

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.
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SBE 19 SEACAT Profiler Instrument Configuration

Used to compute time
between samples.

•  Surface PAR - Select if surface
PAR voltage added by NMEA
interface. Selecting Surface PAR
voltage adds 2 channels to
Channel/Sensor table.

•  NMEA - Select if connected to
optional NMEA interface (SBE
90158 NMEA nterface box with
GPS or LORAN receiver). If
selected, SEASAVE automatically
adds current latitude, longitude,
and universal time code to data
header. Select NMEA (Lat/Lon)
Interface in SEASAVE’s Configure
menu to control how Lat/Lon data
is incorporated.

Select strain gauge or
Digiquartz with temperature compensation

Click a (non-shaded) sensor and click Select
to pick a different sensor for that channel. A
dialog box with a list of sensors appears.
Select sensors after number of voltage
channels have been specified above.

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

Channel/Sensor table reflects this
choice (0, 2, or 4). Must agree with
number programmed into SBE 19; see
configuration sheet or reply from status
command (DS).
Pressure voltage is always last in table.

Return to SBE Data Processing window.
•  If Confirm Configuration Change was selected in

Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

•  If Confirm Configuration Change was not selected
in Configure menu - This button says Save & Exit.
If you do not want to save changes, use Cancel
button to exit.
See SBE 19 configuration sheet
or reply from status command
(DS). Used to determine
strain gauge pressure sensor
data format.
Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.
Click a sensor
and click Modify
to change
calibration
coefficients for
that sensor.

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.
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SBE 21 Thermosalinograph Instrument Configuration

Channel/Sensor table reflects this
choice (0, 1, 2, 3, or 4). Must agree
with number programmed into
SBE 21; see configuration sheet or
reply from status command (DS).

Time between scans.

NMEA - Select if connected to
optional NMEA interface (SBE
90158 NMEA nterface box with
GPS or LORAN receiver). If
selected, SEASAVE
automatically adds current
latitude, longitude, and
universal time code to data
header. Select NMEA (Lat/Lon)
Interface in SEASAVE’s
Configure menu to control how
Lat/Lon data is incorporated.

Click a sensor
and click Modify
to change

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

Re
•  

•  
Click a (non-shaded) sensor and click Select
to pick a different sensor for that channel.
A dialog box with a list of sensors appears.
Select sensors after number of voltage
and frequency channels have been
specified above.
Channel/Sensor table reflects
this choice (0 or 1). Must agree
with number programmed into
SBE 21; see configuration
sheet or reply from status
command (DS).
29

turn to SBE Data Processing window
If Confirm Configuration Change was
Configure menu - If you made chang
not Save or Save As, program asks 
save changes.
If Confirm Configuration Change was
in Configure menu - This button says
If you do not want to save changes, 
button to exit.
Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.
calibration
coefficients for
that sensor.

.
 selected in
es and did
if you want to

 not selected
 Save & Exit.

use Cancel
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SBE 25 SEALOGGER Instrument Configuration

Click a (non-shaded) sensor and click
to pick a different sensor for that chan
A dialog box with a list of sensors app
Select sensors after number of voltag
channels have been specified above.

Channel/Sensor table reflects this choice (0 - 7). Must
agree with number programmed into SBE 25; see
configuration sheet or reply from status command (DS).

Used to determine .hex data format.
See configuration sheet or reply from
status command (DS). 1, 2, 4, or 8 scans/second. Used to calculate

elapsed time while acquiring real-time data.

•  Surface PAR - Select if using
optional SBE 33 Carousel Deck Unit
or SBE 36 CTD Deck Unit to append
Surface PAR data to each scan.
Selecting Surface PAR voltage adds
2 channels to Channel/Sensor table.

•  NMEA - Select if using optional
SBE 33 Carousel Deck Unit or
SBE 36 CTD Deck Unit to append
NMEA position data.SEASAVE
automatically adds current latitude,
longitude, and universal time code to
data header. Select NMEA (Lat/Lon)
Interface in SEASAVE’s Configure
menu to control how Lat/Lon data
is incorporated.

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

Return to SBE Data Processing wind
•  If Confirm Configuration Change w

Configure menu - If you made cha
not Save or Save As, program ask
save changes.

•  If Confirm Configuration Change w
in Configure menu - This button sa
If you do not want to save changes
button to exit.
Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.
 Select
nel.
ears.
e

Click a sensor
and click Modify
to change
calibration
coefficients for
that sensor.

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.

ow.
as selected in
nges and did
s if you want to

as not selected
ys Save & Exit.
, use Cancel
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Calibration Coefficients for Frequency Sensors
View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box.
For all calibration dialog boxes, enter the sensor serial number and calibration
date. Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor.
Temperature, conductivity, and Digiquartz pressure sensors are covered first,
followed by the remaining frequency sensor types in alphabetical order.

Temperature Calibration Coefficients
Enter g, h, i, j (or a, b, c, d), and f0 from the calibration sheet.
Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for temperature sensor drift between calibrations:

Corrected temperature = (slope * computed temperature) + offset
where
slope = true temperature span / instrument temperature span
offset = (true temperature – instrument reading) * slope; measured at 0 °C

Temperature Slope and Offset Correction Example
At true temperature = 0.0 °C, instrument reading = 0.0015 °C
At true temperature = 25.0 °C, instrument reading = 25.0005 °C
Calculating the slope and offset:
Slope = (25.0 – 0.0) / (25.0005 – 0.0015) = + 1.000040002
Offset = (0.0 – 0.0015) * 1.000040002 = - 0.001500060

Sea-Bird temperature sensors usually drift by changing offset, typically
resulting in higher temperature readings over time for sensors with serial
number less than 1050 and lower temperature readings over time for sensors
with serial number greater than 1050. Sea-Bird’s data indicates that the drift is
smooth and uniform with time, allowing users to make very accurate
corrections based only on pre- and post-cruise laboratory calibrations.
Calibration checks at sea are advisable to ensure against sensor malfunction;
however, data from reversing thermometers is rarely accurate enough to make
calibration corrections that are better than those possible from shore-based
laboratory calibrations.

Sea-Bird temperature sensors rarely exhibit span errors larger than ± 0.005 °C
over the range –5 to +35 °C (0.005 °C/(35 -[-5])C/year = 0.000125 °C/C/year),
even after years of drift. A span error that increases more than
± 0.0002 °C/C/year may be a symptom of sensor malfunction.

Notes:
1. Coefficients g, h, i, j, and f0

provide ITS-90 (T
90

)
temperature; a, b, c, d, and f0
provide IPTS-68 (T

68
)

temperature. The relationship
between them is:
T

68
 = 1.00024 T

90

2. See Application Note 31 for
computation of slope and
offset correction coefficients
from pre- and post-cruise
calibrations supplied by
Sea-Bird.
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Conductivity Calibration Coefficients
Enter g, h, i, j, Ctcor (or a, b, c, d, m) and Cpcor from the calibration sheet.
•  Cpcor makes a correction for the highly consistent change in dimensions

of the conductivity cell under pressure. The default is the compressibility
coefficient for borosilicate glass (-9.57e-08). Some sensors fabricated
between 1992 and 1995 (serial numbers between 1100 and 1500) exhibit a
compression that is slightly less than pure borosilicate glass. For these
sensors, the (hermetic) epoxy jacket on the glass cell is unintentionally
strong, creating a composite pressure effect of borosilicate and epoxy.
For sensors tested to date, this composite pressure coefficient ranges from
-9.57e-08 to -6.90e-08, with the latter value producing a correction to
deep ocean salinity of 0.0057 PSU in 5000 dbars pressure (approximately
0.001 PSU per 1000 dbars).
Before modifying Cpcor, confirm that the sensor behaves differently from
pure borosilicate glass. Sea-Bird can test your cell and calculate Cpcor.
Alternatively, test the cell by comparing computed salinity to the salinity
of water samples from a range of depths, calculated using an AutoSal.

Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for conductivity sensor drift between calibrations:

Corrected conductivity = (slope * computed conductivity) + offset
where
slope = true conductivity span / instrument conductivity span
offset = (true conductivity – instrument reading) * slope; measured at 0 S/m

Conductivity Slope and Offset Correction Example
At true conductivity = 0.0 S/m, instrument reading = -0.00007 S/m
At true conductivity = 3.5 S/m, instrument reading = 3.49965 S/m
Calculating the slope and offset:
Slope = (3.5 – 0.0) / (3.49965 - [- 0.00007]) = + 1.000080006
Offset = (0.0 - [-0.00007]) * 1.000080006 = + 0.000070006

The sensor usually drifts by changing span (slope of the calibration curve),
typically resulting in lower conductivity readings over time. Offset error
(error at 0 S/m) is usually due to electronics drift, and is typically less than
± 0.0001 S/m per year. Because offsets greater than ± 0.0002 S/m are a
symptom of sensor malfunction, Sea-Bird recommends that drift corrections
be made by assuming no offset error, unless there is strong evidence to the
contrary or a special need.

Pressure (Paroscientific Digiquartz) Calibration Coefficients
Enter the sets of C, D, and T coefficients from the calibration sheet. Enter zero
for any higher-order coefficients that are not listed on the calibration sheet.
Enter values for slope (default = 1.0; do not change unless sensor has been
recalibrated) and offset (default = 0.0) to make small corrections for
sensor drift.
•  For the SBE 9plus, also enter AD590M and AD590B coefficients from

the configuration sheet.

Note:
See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird or from
salinity bottle samples taken at
sea during profiling.

Note:
Use coefficients g, h, i, j, Ctcor,
and Cpcor (if available on
calibration sheet) for most
accurate results; conductivity for
older sensors was calculated
based on a, b, c, d, m, and Cpcor.

Note:
See Calibration Coefficients for
Voltage Sensors below for
information on strain gauge
pressure sensors.
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Bottles Closed (HB - IOW) Calibration Coefficients
No calibration coefficients are entered for this parameter.
The number of bottles closed is calculated by DATA CONVERSION
based on frequency range.

Sound Velocity (IOW) Calibration Coefficients
Enter coefficients a0, a1, and a2.
Value = a0 + a1 * frequency + a2 * frequency 2
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Calibration Coefficients for Voltage Sensors
View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box.
For all calibration dialog boxes, enter the sensor serial number and calibration
date. Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor. Strain
gauge pressure sensors are covered first, followed by the remaining voltage
sensor types in alphabetical order.

Pressure (Strain Gauge) Calibration Coefficients
Enter A0, A1, and A2 coefficients from the calibration sheet.
•  For older units with a linear fit pressure calibration, enter M (A1) and B

(A0) from the calibration sheet, and set A2 to zero.
•  For all units, offset is normally zero, but may be changed for non-zero

sea-surface condition. For example, if the in-air pressure reading is
negative, enter an equal positive value.

Altimeter Calibration Coefficients
Enter the scale factor and offset.
altimeter height = [300 * voltage / scale factor] + offset
where
scale factor = full scale voltage * 300/full scale range
full scale range is dependent on the sensor (e.g., 50m, 100m, etc.)
full scale voltage is from calibration sheet (typically 5V)

Fluorometer Calibration Coefficients
•  Biospherical Natural Fluorometer

Enter Cfn (natural fluorescence calibration coefficient), A1, A2, and B
from calibration sheet.
natural fluorescence Fn = Cfn * 10V

production = A1 * Fn / (A2 + PAR)
chlorophyll concentration Chl = Fn / (B * PAR)
where
V is voltage from natural fluorescence sensor

Note:
Enter the altimeter alarm set
point, alarm hysteresis, and
minimum pressure to enable
alarm in SEASAVE.

Note:
See Calibration Coefficients for
Frequency Sensors above for
information on Paroscientific
Digiquartz pressure sensors.
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•  Chelsea Aquatracka
Enter VB, V1, Vacetone, slope, offset, and SF.
Concentration (μg/l) = slope*[(10.0(V/SF) - 10.0VB)/(10.0V1 - 10.0Vacetone)]

+ offset
where
VB, V1, and Vacetone are from calibration sheet
Slope (default 1.0) and offset (default 0.0) adjust readings to conform to
measured concentrations
Scale factor SF = 1.0 if CTD gain is 1; SF = 2 if CTD gain is 2.0
V is output voltage measured by CTD

Chelsea Aquatracka Example - Calculation of Slope and Offset
Current slope = 1.0 and offset = 0.0
Two in-situ samples:

Sample 1 –
Concentration (from SBE Data Processing) = 0.390
Concentration (from water sample) = 0.450
Sample 2 –
Concentration (from SBE Data Processing) = 0.028
Concentration (from water sample) = 0.020

Linear regression to this data yields slope = 1.188 and offset = - 0.013

•  Chelsea Minitracka
Enter Vacetone, Vacetone100, and offset.
Concentration = (100 *[V - Vacetone]/[Vacetone100 - Vacetone]) + offset
where
Vacetone (voltage with 0 µg/l chlorophyll) and Vacetone100 (voltage
with 100 µg/l chlorophyll) are from calibration sheet

•  Dr Haardt Fluorometer - Chlorophyll a, Phycoerythrin, or
Yellow Substance
Enter A0, A1, B0, and B1.
These instruments may have automatic switching between high and low
gains. Select the gain range switch:
! Output Voltage Level if the instrument indicates gain by output

voltage level (< 2.5 volts is low gain, > 2.5 volts is high gain)
Low gain:  value = A0 + (A1 * V)
High gain:  value = B0 + (B1 * V)

! Modulo Bit if the instrument has control lines custom-wired to bits in
the SBE 9plus modulo word
Bit set:  value = A0 + (A1 * V)
Bit not set:  value = B0 + (B1 * V)

! None if the instrument does not change gain
value = A0 + (A1 * V)

where
V = voltage from sensor

Dr Haardt Voltage Level Switching Examples
Example: Chlorophyll a
Low range scale = 10 mg/l     and     Gain = 10/2.5 = 4 mg/l/volt
A0 = 0.0 A1 = 4.0
High range scale = 100 mg/l     and     Gain = 100/2.5 = 40 mg/l/volt
B0 = -100 B1 = 40.0

•  Seapoint
Enter gain and offset.
Concentration = (V * 30/gain) + offset
where
Gain is dependent on cable used (see cable drawing, pins 5 and 6)
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•  Sea Tech
Enter scale factor and offset.
Concentration = (voltage * scale factor / 5) + offset
where
Scale factor is dependent on CTD gain and fluorometer range

CTD
Gain

Switch-Selectable Range
(milligrams/m3 or micrograms/liter)

Scale
Factor

0 – 3 3
0 – 10 (default) 10

1.0
(default)

0 - 30 30
0 – 3 1.5
0 – 10 5

2.0

0 - 30 15
Offset is calculated by measuring voltage output when the light sensor is
completely blocked from the strobe light with an opaque substance such
as heavy black rubber:    offset = - (scale factor * voltage) / 5

•  Turner 10-005
This sensor requires two channels - one for the fluorescence voltage and
the other for the range voltage. Make sure to select both when configuring
the instrument.
For the fluorescence voltage channel, enter scale factor and offset.
concentration = [fluorescence voltage * scale factor / (range * 5)] + offset
where
range is defined in the following table

Range Voltage Range
< 0.2 volts 1.0
> 0.2 volts    and    < 0.55 volts 3.16
> 0.55 volts    and    < 0.85 volts 10.0
> 0.85 volts 31.0

•  Turner 10-AU-005
Enter full scale voltage, zero point concentration, and full scale
concentration from the calibration sheet.
concentration = [(1.195 * voltage * (FSC – ZPC)) / FSV] + ZPC
where
voltage = measured output voltage from fluorometer
FSV = full scale voltage; typically 5.0 volts
FSC = full scale concentration
ZPC = zero point concentration

•  WET Labs AC3
This sensor requires two channels - one for fluorometer voltage (listed
under fluorometers in the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.
Enter kv, Vh2o, and A^X.
concentration (mg/m3) = kv * (Vout - Vh20) / A^x
where
Vout = measured output voltage
kv = absorption voltage scaling constant (inverse meters/volt)
Vh20 = measured voltage using pure water
A^x = chlorophyll specific absorption coefficient

Note:
Offset and scale factor may be
adjusted to fit a linear regression
of fluorometer responses to
known chlorophyll a
concentrations.
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•  WET Labs WetStar
Enter Vblank and scale factor.
Concentration (µg/l) = (Vsample - V blank) * scale factor
where
Vsample = in situ voltage output
Vblank = clean water blank voltage output
Scale factor = multiplier (µg/l/Volt)
The calibration sheet lists Vblank and Vcopro (voltage output measured
with known concentration of coproporphyrin tetramethyl ester).
Determine an initial value for the scale factor by using the chlorophyll
concentration corresponding to Vcopro:
scale factor = chlorophyll concentration / (Vcopro - Vblank)
Perform calibrations using seawater with phytoplankton populations that
are similar to what is expected in situ.

OBS/Nephelometer Calibration Coefficients
•  Backscatterance (Downing & Associates [D&A])

Enter gain and offset.
output = (volts * gain) + offset
where
gain = range/5; see calibration sheet for range

•  Chelsea
Enter clear water value and scale factor.
turbidity [F.T.U.] = (10.0V – C) / scale factor
where
V = voltage from sensor
See calibration sheet for C (clear water value) and scale factor

•  Dr. Haardt Turbidity
Enter A0, A1, B0, and B1. Select the gain range switch:
! Output Voltage Level if the instrument indicates gain by output

voltage level (< 2.5 volts is low gain, > 2.5 volts is high gain)
Low gain:  value = A0 + (A1 * V)
High gain:  value = B0 + (B1 * V)

! Modulo Bit if the instrument has control lines custom-wired to bits in
the SBE 9plus modulo word
Bit set:  value = A0 + (A1 * V)
Bit not set:  value = B0 + (B1 * V)

! None if the instrument does not change gain
value = A0 + (A1 * V)

where
V = voltage from sensor

•  IFREMER
This sensor requires two channels - one for the direct voltage and the
other for the measured voltage. Make sure to select both when configuring
the instrument.
For the direct voltage channel, enter vm0, vd0, d0, and k.
diffusion = [k * (vm – vm0) / (vd – vd0)] – d0
where
k = scale factor vm = measured voltage
vm0 = measured voltage offset vd = direct voltage
vd0 = direct voltage offset d0 = diffusion offset

•  Seapoint Turbidity
Enter gain setting and scale factor.
output = (volts * 500 * scale factor)/gain
where
Scale factor is from calibration sheet
Gain is dependent on cable used (see cable drawing)

Note:
In general, turbidity sensors are
calibrated to a standard
(formazin). However, particle size,
shape, refraction, etc. in seawater
varies. These variations affect the
results unless field calibrations
are performed on typical
water samples.
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•  Seatech LS6000
Enter gain setting, slope, and offset.
Output = [volts * (range / 5) * slope] + offset
where
Slope is from calibration sheet.
Range is based on sensor ordered (see calibration sheet) and cable-
dependent gain (see cable drawing to determine if low or high gain):

Range for High Gain Range for Low Gain
2.25 7.5
7.5 25
75 250

225 750
33 100

Oxidation Reduction Potential (ORP) Calibration Coefficients
Enter M, B, and offset (mV).
Oxidation reduction potential = [(M * voltage) + B] + offset
Enter M and B from calibration sheet.

Oxygen Calibration Coefficients
Enter the coefficients, which vary depending on the type of oxygen sensor,
from the calibration sheet:
•  Beckman- or YSI-type sensor (manufactured by Sea-Bird or other

manufacturer) - These sensors require two channels - one for oxygen
current (enter m, b, soc, boc, tcor, pcor, tau, and wt) and the other for
oxygen temperature (enter k and c). Make sure to select both when
configuring the instrument.

•  IOW sensor - These sensors require two channels - one for oxygen current
(enter b0 and b1) and the other for oxygen temperature (enter a0, a1, a2,
and a3). Make sure to select both when configuring the instrument.
Value = b0 + [b1 * (a0 +a1 * T + a2 * T2 + a3 * T3) * C]
where
T is oxygen temperature voltage, C is oxygen current voltage

•  Sea-Bird sensor (new product to be released in late 2000) - This sensor
requires only one channel. Enter soc, boc, tcor, pcor, and tau.

PAR/Irradiance Calibration Coefficients
Enter M, B, calibration constant, and multiplier.
PAR = multiplier * (109 * 10(V-B) / M) / calibration constant
where
•  M = 1.0 and B = 0.0 for integration with SBE 9plus [using light sensor

with built-in log amplifier (Biospherical model QSP-200L)];
or M and B are taken from log amplifier calibration sheet for integration
with SBE 16, 19, or 25

•  Calibration constant is dependent on sensor type:
! Biospherical PAR sensor

Calibration constant (for QSP-200L)
= 105 / wet calibration factor from calibration sheet
Calibration constant (for QSP-200PD)
= 109 /calibration coefficient from calibration sheet

! LI-COR PAR sensor
Calibration constant is LI-COR in water calibration constant from
calibration sheet.

•  Multiplier can be used to scale output, and is typically set to 1.0.

Notes:
1. Enter soc and boc values from the

most recent field calibration for
Beckman-type, YSI-type, or
Sea-Bird oxygen sensor.

2. See Application Notes 13-1 and
13-3 for complete description of
calculation of calibration
coefficients for Beckman- or
YSI-type sensors.

Note:
See Application Notes 11 LICOR
(LI-COR sensor), 11 QSP-L
(Biospherical sensor with built-in
log amplifier), and 11-QSP-PD
(Biospherical sensor without
built-in log amplifier) for complete
description of calculation of
calibration coefficients.
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pH Calibration Coefficients
Enter the slope and offset from the calibration sheet:
pH = 7 + (Vout – offset) / (°K * 1.98416e-4 * slope)
where
°K = temperature in degrees Kelvin

Pressure/FGP (voltage output) Calibration Coefficients
Enter scale factor and offset.
output [Kpa] = (volts * scale factor) + offset
where:
scale factor = 100 * pressure sensor range [bar] / voltage range [volts]

Transmissometer Calibration Coefficients
•  Sea Tech, Chelsea (Alphatracka), and WET Labs Cstar

Enter M, B, and path length (in meters)
Path length (distance between lenses) is based on sensor size
(for example, 25cm transmissometer = .25m path length, etc.).
light transmission (%) = M * volts + B
where
M = (Tw/W0) (A0 – Y0) / (A1 – Y1)
B = - M * Y1
and
A0 = air calibration voltage (approximately 4.7 volts) from calibration
sheet
A1 = current air voltage
Y0 = blocked path (dark) voltage (approximately 0.0 volts) from
calibration sheet
Y1 = current blocked path (dark) voltage
W0 = voltage output in pure water from calibration sheet
Tw = % transmission in pure water

Tw = % Transmission in Pure Water
Wavelength 10 cm Path Length 25 cm Path Length

488 nm (blue) 99.8% 99.6%
532 nm (green) 99.5% 98.8%
660 nm (red) 96.0 - 96.4% 90.2 - 91.3%

Sea Tech Light Transmission Example
Tw = 91.3, W0 = 4.565, A0 = 4.743 volts, and Y0 = 0.002 volts
(from calibration sheet)
A1 = 4.719 volts and Y1 = 0.006 volts (from current calibration)
M = 20.119
B = -0.1207

•  WET Labs AC3
This sensor requires two channels - one for fluorometer voltage (listed
under fluorometers in the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.
Enter Ch2o, Vh2o, VDark, and X from calibration sheet.
Beam attenuation = {[log (Vh2o - VDark) - log (V - VDark)] /X} + Ch2o
Beam transmission (%) = exp ( -beam attenuation * X) * 100

Note:
DOS SEASOFT < version 4.008
ignored temperature compensation of
a pH electrode. The relationship
between the two methods is:
pH = pH old + (7 – 2087/°K)
For older sensors, run pHfit version
2.0 (included with DOS SEASOFT)
using Vout, pH, and temperature
values from the original calibration
sheet to compute the new values for
offset and slope to enter in the
configuration file.

Note:
See Application Note 7 for
complete description of
computation of M and B.
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User Polynomial (for user-defined sensor) Calibration Coefficients
Enter a0, a1, a2, and a3.
Val = a0 + (a1 * V) + (a2 * V2) + (a3 * V3)
where:
V = voltage from sensor
a0, a1, a2, and a3 = user-defined sensor polynomial coefficients

Zaps Calibration Coefficients
Enter M and B from calibration sheet.
z = (M * volts) + B [nmoles]
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Section 6: Acquisition, Playback, and
Conversion of Raw Data Modules

Module Name Module Description
SEASAVE Acquire real-time data, display raw archived data.

SEASAVE is a stand-alone module. See SEASAVE
for Windows Manual for details.

DATA
CONVERSION

Convert raw data (.hex or .dat file) to engineering
units, storing the converted data in .cnv file.

ROSETTE
SUMMARY

Summarize data from rosette (water sampler bottle)
.ros file, storing the results in .btl file.
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DATA CONVERSION
DATA CONVERSION:
1. Converts raw data from an input .dat file (from an SBE 911plus) or

.hex file (from other CTDs) to engineering units, and
2. Stores the converted data in a .cnv file and (optional) .ros file.

The File Setup tab in the dialog box looks like this:
Location to store all information
input in File Setup and Data
Setup tabs. Open to select a
different .psu file, Save or
Save As to save current
settings, or Restore to reset
all settings to match last
saved version.

Instrument configuration file
location. Select to pick a
different .con file, or Modify to
view and/or modify instrument
configuration. (see below for
Configuration dialog box)

Select if more than 1 data file is to be
processed, and data files have different
.con files. For example, if processing
test.dat and test1.dat, and this option is
selected, program will search for test1.con
(in the same directory as test.con) to
process test1.dat.

Directory and file names for
raw data (.dat or .hex). Select
to pick a different file. To
process multiple raw data files
from same directory:
1. Click Select.
2. In Select dialog box, hold

down Ctrl key while clicking
on each desired file.

Directory and file names for converted output (.cnv) data.
•  If more than 1 data file is to be processed, Output file field

disappears and output file name is set to match input file
name. For example, if processing test.dat and test1.dat,
output files will be named test.cnv and test1.cnv.

•  SBE Data Processing adds Name append to (each) output
file name, before .cnv extension. For example, if processing
test.dat and test1.dat with a Name append of 06-20-00,
output files will be test06-20-00.cnv and test106-20-00.cnv.

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.
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The Configuration dialog box appears when you select Modify for the
instrument configuration file on the File Setup tab. The Configuration dialog
box is part of the CONFIGURE module (see Section 5: Configuring the
Instrument for full details for each instrument). The dialog box looks like this
for an SBE 9plus (other instruments are similar):

Note that the sensors and channels in this dialog box must correspond to the
setup of your system. You will select which data fields to convert and process
on the Data Setup tab of DATA CONVERSION’s dialog box.

Channel/Sensor table below
reflects these choices.

Shaded sensors cannot be removed
or changed to another type of sensor.
All others are optional.

Applicable only to
SBE 9plus. For full rate
data, set to 1.

Selecting Surface PAR
voltage adds 2 channels
to table below.

Select to include time of each scan
with data (if available in raw data file).

Click a (non-shaded) sensor and
click Select to pick a different
sensor for that channel. A dialog
box with a list of sensors appears.

Click a sensor and click Modify to
change the calibration coefficients
for that sensor. See Section 5 for
details on calibration coefficients.

• New to create a new
.con file for this CTD.

• Open to select a
different .con file.

• Save or Save As to
save current .con file
settings.

Opens a .txt file (for viewing
and printing only; cannot be
modified) that shows all
parameters in .con file.

Return to File Setup tab.
• If Confirm Instrument Configuration Change was

selected in DATA CONVERSION’s Options menu -
If you made changes and did not Save or Save As,
program asks if you want to save changes.

• If Confirm Instrument Configuration Change was not
selected in DATA CONVERSION’s Options menu -
This button says Save & Exit. If you do not want to
save changes, use Cancel button to exit.
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The Data Setup tab in the dialog box looks like this:

The Select Output Variables dialog b
Select Output Variables on the Data

Program skips first scans to skip
over scans.
•  If Process scans to end of file

selected: process all
remaining scans (upcast
and downcast scans if Upcast
and downcast selected;
downcast scans only if
downcast selected).

•  If Process scans to end of file
not selected: process next
scans to process.

•  

•  
TR
bin

Select which variables to
convert and output
(see dialog box below).

Select to replace existing
header in input file with header
in .hdr file. Program looks for a
file with a matching name (but
.hdr extension) in same
directory as input file.

Define scans
CTD data file
included in b
for each bottl
discussion be

•  Add variable: click blank field in
Variable Name column, click desired
variable in list, click Add.

•  Change variable: click existing variable
in Variable Name column, click desired
variable in list, click Change.

•  Insert variable: click existing variable
below desired sequence # in Variable
Name column, click desired variable in
list, click Insert.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selec

changes and did not Save or Save As, progra
•  If Confirm Program Setup Change was not se

says Save & Exit. If you do not want to save 

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
Binary - smaller file, processed faster than ASCII
file by other SBE Data Processing modules.
ASCII - larger file, can be viewed with a text editor.
ANSLATE can translate converted data file from
ary to ASCII or vice versa.
ox (which
 Setup tab

Create converted data file only,
bottle file only (for subsequent
processing by ROSETTE
SUMMARY), or both.

 from
 to be
ottle file
e (see
low).

ted in Optio
m asks if y
lected in O
changes, u
Source of data for creating bottle file:
•  (in same directory as input data file, with

same file name) auto fire module (.afm)
file, bottle log (.bl) file, or bottle scan
range (.bsr) file, or

•  scans marked with bottle confirm bit in
input data file

See DATA CONVERSION: Creating Water
Bottle (.ros) Files below for details.
 appears when you click
) looks like this:

ns menu - If you made
ou want to save changes.
ptions menu - This button
se Cancel button to exit.
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DATA CONVERSION: Creating Water Bottle (.ros) Files
A .ros water bottle file contains:
•  data for each scan associated with a bottle firing, and
•  data for user-selected range of scans before and after each bottle firing

Scan range data for creation of a water bottle file can come from:

•  Auto Fire module (.afm) file - if used PN 90208 Carousel Auto Fire
Module (AFM) with SBE 19 or 25 to interface with water sampler. For
these systems, the .afm file contains five scans of data recorded by the
AFM for each bottle firing.

•  Scans marked with bottle confirm bit in input data file - if used
SBE 911plus or SBE 9plus with SBE 17plus to interface with water
sampler. For these systems, the bottle confirm bit in the input data file is
set for all scans within a 1.5-second duration after a bottle firing
confirmation is received from the water sampler.

•  Bottle log (.bl) file - if used SEASAVE to interface with water sampler.
For these systems, SEASAVE creates the .bl file. Each time a bottle fire
confirmation is received, the bottle sequence number, position, date, time,
and beginning and ending scan numbers (1.5-second duration for each
bottle) are written to the .bl file.

•  Bottle scan range (.bsr) file - if used Mark Scan feature in SEASAVE
during data acquisition to create a .mrk file; use MARK SCAN to convert
the .mrk file to a .bsr file before running DATA CONVERSION.
The format for the .bsr file is
beginning scan # for bottle #1, ending scan # for bottle #1
…
beginning scan # for last bottle, ending scan # for last bottle
Example: test.bsr contains -
1000, 1020
2000, 2020
4000, 4020
The .ros file created using test.bsr would contain scans 1000 - 1020 for
bottle #1, 2000 - 2020 for bottle #2, and 4000 - 4020 for bottle #3.

The amount of data written to the .ros file is based on:

•  Scan range offset - determines the first scan output to the .ros file for
each bottle, relative to the first scan with a confirmation bit set or written
to a .afm, .bsr, or .bl file.

•  Scan range duration - determines the number of scans output to the .ros
file for each bottle.

Example: A bottle confirmation for an SBE 911plus is received at scan 10,000
(scan 10,000 and subsequent scans for 1.5 seconds have confirmation bit set).
In DATA CONVERSION, Scan range offset is set to -2 seconds, and Scan
range duration is set to 5 seconds. If the scan rate is 24 scans/second,
10,000 - 2 second offset (24 scans/second) = 9,952
9,952 + 5 second duration (24 scans/second) = 10,072
Therefore, scans 9,952 through 10,072 will be written to the .ros file.

Note:
You can create a .bsr file in
a text editor if scan range
data is not available in any
of these forms.
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DATA CONVERSION: Notes and General Information

DATA CONVERSION was written to accommodate most (if not all) sensors
that have been installed on Sea-Bird products. Consult the configuration page
at the beginning of your instrument manual for the sensors that were installed
in your system.

•  If you plan to post-process the data, select only the primary variables
to be converted. Use DERIVE to compute derived oceanographic
parameters such as salinity, density, sound velocity, oxygen, and dynamic
height anomaly.

•  If you will use DERIVE:
! To compute salinity, density, or other parameters that depend on

salinity - include pressure, temperature, and conductivity in the
output file

! To compute oxygen - include oxygen current and oxygen temperature
in the output file along with pressure, temperature, and conductivity

•  If you will use BIN AVERAGE:
! With depth bins - include depth in the output file
! With pressure bins - include pressure in the output file

•  Pressure temperature is computed using a backward-looking, 30-second
running average, to prevent bit transitions in pressure temperature from
causing small jumps in computed pressure. Because the heavily insulated
pressure sensor has a thermal time constant on the order of one hour,
the 30-second average does not significantly alter the computed
pressure temperature.

•  Oxygen values computed by SEASAVE and DATA CONVERSION will
be somewhat different from values computed by DERIVE, because the
oxygen algorithm uses the parameter doc/dt (derivative of oxygen current
with respect to time). SEASAVE and DATA CONVERSION compute
doc/dt looking backward in time, since they share common code and
SEASAVE cannot use future values of oxygen current while acquiring
data in real time. DERIVE uses a centered window (equal number of
points before and after the scan) to obtain a better estimate of doc/dt. Use
SEASAVE and DATA CONVERSION to obtain a quick look at oxygen
values; use DERIVE to obtain the most accurate values.
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DATA CONVERSION adds the following to the data file header for a
.cnv converted data file:

Nquan Number of columns (fields) of converted data.
Note: DATA CONVERSION automatically adds
1 field to the number selected by the user (i.e., if the
user selects 3 variables to convert, then nquan=4). This
field, initially set to 0, is used by LOOP EDIT to mark
bad scans.

Nvalues Number of scans converted
Units Specified (indicates units are specified separately for

each variable; DOS SEASOFT required all units to be
English or metric).

Name n Sensor (and units) associated with data in column n.
Span n Span (highest - lowest value) of data in column n.
Interval Scan rate (seconds).
Start_time Data start time.
Bad_flag Provided for information only; value that LOOP EDIT

will use to mark bad scans and WILD EDIT will use to
mark bad data values.

Sensor n Sensor description, serial number, and calibration date.
Datcnv_date Date and time that module was run.
Datcnv_in Input .dat (or .hex) and .con files.
Datcnv_skipover Number of scans to skip over in processing.
File type Selected output file type - ascii or binary.

DATA CONVERSION adds the following to the data file header for a
.ros water bottle file:

Nquan Number of columns (fields) of converted data.
Note: DATA CONVERSION automatically adds
1 field to the number selected by the user (i.e., if the
user selects 3 variables to convert, then nquan=4). This
field, initially set to 0, is used by LOOP EDIT to mark
bad scans.

Nvalues Number of scans converted
Units Specified (indicates units are specified separately for

each variable; DOS SEASOFT required all units to be
English or metric).

Name n Sensor (and units) associated with data in column n.
Interval Scan rate (seconds).
Start_time Data start time.
Sensor n Sensor description, serial number, and calibration date.
Datcnv_date Date and time that module was run.
Datcnv_in Input .dat (or .hex) and .con files.
Datcnv_bottle_
scan_range_source

Source of data for creating bottle file, and scan range
offset and duration.

Note:
Each SBE Data Processing
module that modifies a .cnv file
adds information to the header
and updates nquan, nvalues,
name n, span n, interval, and
file_type, as applicable.
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ROSETTE SUMMARY
ROSETTE SUMMARY reads a .ros file created by DATA CONVERSION
and writes a bottle data summary to a .btl file. The .ros file must contain (as a
minimum) temperature, pressure, and conductivity (or salinity).
The output .btl file includes:
•  Bottle position, optional bottle serial number, and date/time
•  User-selected derived variables - computed for each bottle from mean

values of input variables (temperature, pressure, conductivity, etc.)
•  User-selected averaged variables - computed for each bottle from

input variables
The maximum number of scans processed per bottle is 1440.

In addition to the .ros input file:
•  If a .bl file (same name as input data file, with .bl extension) is found in

the input file directory, ROSETTE SUMMARY uses bottle position data
from the .bl file. The bottle position data defines the bottle firing sequence
- the first column is the firing sequence number and the second column is
the bottle position.

•  If a .sn file (same name as input data file, with .sn extension) is found in
the input file directory, bottle serial numbers are inserted between the
bottle position and date/time columns in the .btl file output. The format
for the bottle serial number file is:
Bottle position, serial number     (with a comma separating the two fields)

The Data Setup tab in the dialog box looks like this:

ROSETTE SUMMARY adds the following to the data file header:
Rossum_date Date and time that module was run.
Rossum_in Input .ros and .con files.

Note:
You can create a .sn file in a
text editor.

Select input variables to be averaged. Mean and
standard deviation will be calculated and output for
each bottle.
•  If Output min/max values for averaged variables

is selected, minimum and maximum values will
also be output for each bottle.

Select variables to derive from input data. Derived variables
are computed from mean values of input variables
(temperature, conductivity, pressure, etc.) for each bottle.
•  Oxygen can be derived if oxygen current and oxygen

temperature are in the .ros file. ROSETTE SUMMARY
calculates doc/dt, using a least squares fit to all the oxygen
current data for each bottle. Oxygen is calculated using the
mean values for temperature, pressure, and salinity,
doc/dt, and the scan-by-scan values of oxygen current and
oxygen temperature.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.
Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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Section 7: File Editing Modules
Module Name Module Description
ASCII IN Add header information to a .asc file containing rows

and columns of ASCII data.
MARK SCAN Create .bsr bottle scan range file from .mrk data file.
SECTION Extract rows of data from .cnv file.
SPLIT Split data in .cnv file into upcast and downcast files.
STRIP Extract columns of data from .cnv file.
TRANSLATE Convert data format in .cnv file from ASCII to binary,

or vice versa.



                                                                                     Section 7: File Editing Modules                                                                                     

50

ASCII IN
ASCII IN adds a header to a .asc file that contains row and columns of ASCII
data. The output file, which contains both the header and the data, is a .cnv
file. ASCII IN can be used to add a header to data that was generated by a
non-SEASOFT program.

The Data Setup tab in the dialog box looks like this:

ASCII IN creates a data file header containing the following information:
Nquan Number of columns (fields) of data.

NOTE: ASCII IN automatically adds 1 field to the number
of fields in the input .asc file (i.e., if the .asc file contains
3 columns of data, then nquan=4). This field, initially set to 0,
is used by LOOP EDIT to mark bad scans.

Nvalues Number of scans converted.
Units Specified (indicates units are specified separately for each

variable; DOS SEASOFT required all units to be English
or metric).

Name n Sensor (and units) associated with data in column n.
Span n Span (highest - lowest value) of data in column n.
Interval Scan rate (seconds).
Start_time Start time for when ASCII IN was run.
Bad_flag Provided for information only; value that LOOP EDIT will

use to mark bad scans and WILD EDIT will use to mark bad
data values.

Asciiin_in Input .asc file.
File type Selected output file type - ascii data.

Select variable name associated
with each column of data, to be
put in header. Selection list
includes all variables that can be
output by DATA CONVERSION
and DERIVE, as well as user-
defined variable names.

Select whether interval between
scans is based on time,
pressure, or depth, and indicate
the interval value (time, pressure,
or depth between scans). This
information is put in header.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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MARK SCAN
MARK SCAN creates a bottle scan range (.bsr) file from a .mrk data file
created in SEASAVE. The data in the .bsr file can then be used by DATA
CONVERSION to create a .ros file. The .ros file can then be used by
ROSETTE SUMMARY to create a bottle data summary .btl file.

The input .mrk file contains one scan with the mark number, system time, and
scan number for each time Mark Scan was clicked while in SEASAVE’s Mark
Scan Control dialog box (accessed by selecting Mark Scan Control in
SEASAVE’s View menu). MARK SCAN’s output .bsr file points to a user-
defined range of adjacent scans for each marked scan. Note that the output .bsr
file only contains the pointers to the scans, and does not contain the data.

The Data Setup tab in the dialog box looks like this:

MARK SCAN’s output .bsr file does not have a header.

Note:
Alternatively, an ASCII text editor can
be used to create the .bsr file. The
format for the output .bsr file is:
Beginning scan for bottle 1, ending scan for
bottle 1
Beginning scan for bottle 2, ending scan for
bottle 2
.
.
Beginning scan for last bottle, ending scan
for last bottle

Note that a comma must separate the
beginning and ending scan numbers.

Define the range of scans around each scan in
the .mrk file to include in the .bsr file.
•  offset - number of scans before or after scan

in .bsr file for starter pointer
•  duration - number of scans to include in .bsr

file for each scan in .mrk file
Example: Offset is -5 scans and duration is
10 scans. If .mrk file contains scans 16 and
128, .bsr file will look like this:
11, 21            (16-5=11; 11+10=21)
123, 133        (128-5=123; 123+10=133)

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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SECTION
SECTION extracts rows of data from the input .cnv file, based on a pressure
range or scan number range, and writes the rows to an output .cnv file.

The Data Setup tab in the dialog box looks like this:

SECTION adds the following to the data file header:
Section_date Date and time that module was run.
Section_in Input .cnv file.
Section_type Evaluate data based on pressure or scan range.
Section_range Range of (pressure or scan count) data to keep.

Select Upcast or Downcast if
section is based on pressure.

SECTION based on a pressure range
or a scan range.

SECTION writes to the output file
all rows of data that fall within this
range of pressure or scan number.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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SPLIT
SPLIT splits the data from an input .cnv file into upcast (pressure decreasing)
and downcast (pressure increasing) files. SPLIT writes the data to an output
.cnv file(s). The upcast output file name is the input file name prefixed by u.
The downcast output file name is the input file name prefixed by d.

The Data Setup tab in the dialog box looks like this:

SPLIT adds the following to the data file header:
Split_date Date and time that module was run.
Split_in Input .cnv file.
Split_excl_bad_scans If Yes, pressure from scans marked with badflag (in

LOOP EDIT) were not used to determine
maximum pressure (for determining when
downcast ends and upcast begins).

Note:
BIN AVERAGE provides the option of
processing upcast, downcast, or
both, possibly removing the need to
run SPLIT.

Output an upcast file (prefix u) and
downcast (prefix d) file, or just a
downcast (prefix d) file.

If selected, scans marked with badflag (in
LOOP EDIT) will not be used to identify
maximum pressure. Maximum pressure
defines when downcast ends and upcast
begins.
Note: Pressure values marked with
badflag in WILD EDIT are never used to
determine maximum pressure.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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STRIP
STRIP outputs selected columns of data from the input .cnv file. STRIP writes
the data to an output .cnv file.

The Data Setup tab in the dialog box looks like this:

STRIP adds the following to the data file header:
Strip_date Date and time that module was run.
Strip_in Input .cnv file.

Select which variables (columns
of data) to output.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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TRANSLATE
TRANSLATE changes the converted data file format from binary to ASCII or
vice versa, and writes the data to an output .cnv file.

The Data Setup tab in the dialog box looks like this:

TRANSLATE changes the following in the data file header:
File_type File type - changes to ascii or binary, as applicable.

Switch from:
•  Binary to ASCII,
•  ASCII to binary, or
•  Binary to ASCII or ASCII to binary,

as applicable (if you do not know
the input file type)

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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Section 8: Data Manipulation Modules
All data manipulation is performed on converted data from a .cnv file.

Module Name Module Description
ALIGN CTD Align data relative to pressure (typically used for

conductivity, temperature, and oxygen).
BIN
AVERAGE

Average data, basing bins on pressure, depth, scan
number, or time range.

BUOYANCY Compute Brunt Väisälä buoyancy and stability
frequency.

CELL
THERMAL
MASS

Perform conductivity thermal mass correction.

DERIVE Calculate salinity, density, sound velocity, oxygen,
potential temperature, dynamic height, etc.

FILTER Low-pass filter columns of data.
LOOP EDIT Mark a scan with badflag if scan fails pressure reversal or

minimum velocity tests.
WILD EDIT Mark a data value with badflag to eliminate wild points.
WINDOW
FILTER

Filter data with triangle, cosine, boxcar, gaussian, or
median window.
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ALIGN CTD
ALIGN CTD aligns parameter data in time, relative to pressure. This ensures
that calculations of salinity, dissolved oxygen concentration, and other
parameters are made using measurements from the same parcel of water.
Typically, ALIGN CTD is used to align temperature, conductivity, and oxygen
measurements relative to pressure.

There are three principal causes of misalignment of CTD measurements:
Note:
ALIGN CTD cannot be run on files
that have been averaged into
pressure or depth bins in BIN
AVERAGE. If alignment is necessary,
run ALIGN CTD before running
BIN AVERAGE.
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•  physical misalignment of the sensors in depth
•  inherent time delay (time constants) of the sensor responses
•  water transit time delay in the pumped plumbing line - the time it takes

the parcel of water to go through the plumbing to each sensor (or, for free-
flushing sensors, the corresponding flushing delay, which depends on
profiling speed)

When measurements are properly aligned, salinity spiking (and density) errors
are minimized, and oxygen data corresponds to the proper pressure (e.g.,
temperature vs. oxygen plots agree between down and up profiles).

The Data Setup tab in the dialog box looks like this:

The Enter Advance Values dialog box looks like this:

Define alignment times. The
diagram shows the sign
convention for Advance. If
0 seconds is entered, alignment
relative to pressure (and time)
remains unchanged for that
variable. See discussion below to
determine appropriate alignment
times for conductivity,
temperature, and oxygen.

- Advance
(delay)

+ Advance

Time

Upcast and Downcast mismatch with
Respect to Pressure Define alignment times for all data.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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ALIGN CTD: Conductivity and Temperature
Temperature and conductivity are often misaligned with respect to pressure.
Shifting temperature and conductivity relative to pressure can compensate.
As shown in the figures, indications of misalignment include:
•  Depth mismatch between downcast and upcast data
•  Spikes in the calculated salinity (which is dependent on temperature,

conductivity, and pressure) - caused by misalignment of temperature and
conductivity with each other

The best diagnostic of proper alignment is the elimination of salinity spikes
that coincide with very sharp temperature steps. To determine the best
alignment, plot 10 meters of temperature and salinity data at a depth that
contains a very sharp temperature step. For the downcast, when temperature
and salinity increase with increasing pressure:
•  A negative salinity spike at the conductivity step means that conductivity

leads temperature (conductivity sensor sees step before temperature sensor
does). Advance conductivity relative to temperature a negative number
of seconds.

•  Conversely, if the salinity spike is positive, advance conductivity relative
to temperature a positive number of seconds.

The best alignment of conductivity with respect to temperature is obtained
when the salinity spikes are minimized. Some experimentation with different
advances is required to find the best alignment.

When using free flushing conductivity sensors, keep the profiling speed
greater than 0.7 meters/second, because of thermal contamination of the
conductivity measurement at lower speeds.

Typical Temperature Alignment

•  SBE 19 - Because the SBE 19 uses a temperature sensor with a relatively
slow time constant, a typical correction is to advance temperature relative
to pressure + 0.5 seconds.

•  SBE 9plus and SBE 25 - Because the time response of the SBE 3
temperature sensor is fast (0.06 seconds), it is not necessary to advance
temperature relative to pressure for the SBE 9plus and 25 (which use the
SBE 3).
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Typical Conductivity Alignment

•  SBE 9plus - For an SBE 9plus with TC-ducted temperature and
conductivity sensors and a 3000 rpm pump, the typical lag of conductivity
relative to temperature is 0.073 seconds. Following is an example of
determining the value to enter in ALIGN CTD:
Example: The SBE 11plus is factory-set to advance the primary
conductivity +1.75 scans (at 24 Hz, this is 1.75/24 = 0.073 seconds).
Advance conductivity relative to temperature in ALIGN CTD:
0.073 - 1.75/24 = 0.0 seconds     (enter 0 seconds for conductivity).

•  SBE 19 - For a given sensor configuration, the conductivity measurement
may lead or lag that of temperature. This is especially true of unpumped
SBE 19 data, where the flushing rate of the conductivity cell depends on
drop speed. If the SBE 19 is lowered very slowly (<20cm/second,
typically from a fixed platform or ice), conductivity lags temperature. If
the SBE 19 is lowered fast, conductivity leads temperature. Typical
advances of conductivity relative to temperature range from 0 seconds at
a lowering rate of 0.75 meters/second to -0.6 seconds for 2 meters/second
(if temperature was advanced +0.5 seconds, these correspond to
conductivity advances of +0.5 seconds and -0.1 seconds respectively).

•  SBE 25 - For an SBE 25 with a standard 2000 rpm pump, a typical
advance of conductivity relative to temperature is +0.1 seconds.

Note that if temperature is advanced relative to pressure and you do not
want to change the relative timing of temperature and conductivity, you
must add the same advance to conductivity.
Example (typical of SBE 19 data):
Advance temperature relative to pressure +0.5 seconds to compensate for slow
response time of sensor.
If the CTD is lowered at 0.75 m/s, advance conductivity relative to
temperature 0 seconds. Calculate advance of conductivity relative to pressure
to enter in ALIGN CTD:  +0.5 + 0 = +0.5 seconds

If the CTD is lowered at 2 m/s, advance conductivity relative to temperature
-0.6 seconds. Calculate advance of conductivity relative to pressure to enter in
ALIGN CTD:  +0.5 + (-0.6) = -0.1 seconds

ALIGN CTD: Oxygen

Oxygen data is also systematically delayed with respect to pressure. The two
primary causes are the long time constant of the oxygen sensor (ranging from
2 seconds at 25 ºC to approximately 5 seconds at 0 ºC) and an additional delay
from the transit time of water in the pumped plumbing line. As with
temperature and conductivity, you can compensate for this delay by shifting
oxygen data relative to pressure. Typical advances are:
•  SBE 9plus: +2 to +5 seconds (pumped), +1 to +5 seconds (unpumped)
•  SBE 19: +3 to +7 seconds (pumped), +1 to +5 seconds (unpumped)
•  SBE 25: +3 to +7 seconds (pumped), +1 to +5 seconds (unpumped)

ALIGN CTD adds the following to the data file header:
Alignctd_date Date and time that module was run.
Alignctd_in Input .cnv file.
Alignctd_adv Variables aligned and their respective alignment times.

Note:
All SBE 11 series deck units can
advance primary conductivity, which
may eliminate the need to use ALIGN
CTD. The SBE 11plus does not
advance secondary conductivity.
The SBE 11plus V2 can advance
secondary conductivity and all
voltage channels; the advance time is
user-programmable.
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BIN AVERAGE
BIN AVERAGE averages data, using averaging intervals based on:
•  pressure range,
•  depth range,
•  scan number range, or
•  time range

The Data Setup tab in the dialog box looks like this:

BIN AVERAGE: Formulas
The center value of the first (not surface) bin is set equal to the bin size.

Example (pressure bin, surface bin not included):
Bin size is 10 db. The first bin is defined as follows:

Note:
ALIGN CTD, which aligns parameter
data in time, relative to pressure,
cannot be run on files that have been
averaged into pressure or depth bins
in BIN AVERAGE. If alignment is
necessary, run ALIGN CTD before
running BIN AVERAGE.

Note:
If Exclude scans marked bad is
selected in the dialog box, data from
scans marked with badflag in LOOP
EDIT are not used in calculating
average. Values marked with badflag
by WILD EDIT are never included in
calculating the average. If the
number of points included in the
average is 0 (all data and/or scans in
the bin are marked with badflag), the
average value is set to badflag.

Center (target) first bin =
bin size=10 db

First bin
Bin size=10 db

surface = 0 db

Minimum first bin = BinMin =
bin size - (bin size/2) = 5 db

Maximum first bin = BinMax =
bin size + (bin size/2) = 15 db

Average by:
•  pressure (with or without interpolation)
•  depth (with interpolation)
•  scan number
•  time (seconds or hours)
If pressure (or depth) is not included in input
file, it will not appear on list of bin types.

Bin size is range of data for each bin (i.e.,
pressure range, scan number range, etc.).

If selected, data from scans marked with
badflag in LOOP EDIT will not be used in
calculating average. Note that values marked
with badflag by WILD EDIT are never
included in calculating average.

Process downcast, upcast, or both.

If selected, a column containing number of
scans in each bin will be added to output data.

If selected, include surface bin (applicable only if
averaging by pressure or depth). Input:
•  minimum and maximum values - minimum and

maximum (pressure or depth, as applicable) to
be used in calculating surface bin

•  value - target value (pressure or depth) to be
associated with averages

Note that surface bin minimum, maximum,
and value do not affect minimum, maximum,
and center of first or subsequent bins.

Skip first n scans of data before
beginning processing.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.
Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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Example (pressure bin, surface bin included):
Bin size is 10 db. Surface bin is included, and surface bin parameters are 0 db
minimum, 3 db maximum, and 0 db value. The bins are defined as follows:

The algorithms used for each type of averaging follow.

Pressure Bins (no interpolation)
For each bin:
BinMin = center value - (bin size / 2)
BinMax = center value + (bin size / 2)

1. Add together valid data for scans with BinMin < pressure < BinMax.
2. Divide the sum by the number of valid data points to obtain the average.
3. Write the average to the output file.
4. Repeat Steps 1 through 3 for each variable.
5. For the next bin, compute the center value and repeat Steps 1 through 4.

Pressure Bins (with interpolation)
For each bin:
BinMin = center value - (bin size / 2)
BinMax = center value + (bin size / 2)

1. Add together valid data for scans with BinMin < pressure < BinMax.
2. Divide the sum is by the number of valid data points to obtain the average.
3. Interpolate as follows:

Pp =average pressure of previous bin
Xp =average value of variable in previous bin
Pc =average pressure of current bin
Xc =average value of variable in current bin
Pi = center value for pressure in current bin
Xi =interpolated value of variable (value at center pressure Pi )
     = ( (Xc - Xp) * (Pi - Pp) / (Pc - Pp) ) + Xp

4. Write the interpolated value to the output file.
5. Repeat Steps 1 through 4 for each variable.
6. Compute the center value and Repeat Steps 1 through 5 for the next bin.

Values for the first bin are interpolated after the averages for the second bin
are calculated; values from the next (second) bin instead of the previous bin
are used in the equations.

Depth Bins
Depth bin processing is similar to processing for pressure bins with
interpolation, but bin size and center values are based on depth.

Center (target) first bin =
bin size=10 db

First bin
Bin size=10 db

minimum surface bin = 0 db
target surface bin = 0 db

Minimum first bin = BinMin =
bin size - (bin size/2) = 5 db

Maximum first bin = BinMax =
bin size + (bin size/2) = 15 db

maximum surface bin = 3 db

Surface bin
Bin size=3 db
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Scan Number Bins
Scan number bin processing is similar to processing for pressure bins without
interpolation. If exclude scans marked bad is selected, BIN AVERAGE
averages bin size good scans (not marked with badflag in LOOP EDIT).

Example: Bin size is 100. First bin should include scans 50 - 149. However,
scans 93, 94, and 126 are marked with badflag in LOOP EDIT, and the user
selected exclude scans marked bad. To include 100 valid scans in the average,
BIN AVERAGE includes scans 50 - 152 in the first bin.

Time Bins
Time bin processing is similar to processing for pressure bins without
interpolation. BIN AVERAGE determines the number of scans to include
based on the input bin size and the data sampling interval:

Number of scans = bin size [seconds] / interval
or
Number of scans = (bin size [hours] x 3600 seconds/hour) / interval

BIN AVERAGE adds the following to the data file header:
Binavg_date Date and time that module was run.
Binavg_in Input .cnv file.
Binavg_bintype Bin type (pressure, depth, scans time in seconds, or

time in hours).
Binavg_binsize Bin size.
Binavg_excl_bad_
scans

If yes, values from scans marked with badflag in
LOOP EDIT are not included in average.

Binavg_skipover Number of scans skipped over.
Binavg_surface_bin Surface bin included? Minimum and maximum

values for surface bin.
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BUOYANCY
BUOYANCY calculates buoyancy (Brunt-Väisälä) frequency (N) and stability
(E) using the Fofonoff adiabatic leveling method (Bray N. A. and N. P.
Fofonoff (1981) Available potential energy for MODE eddies. Journal of
Physical Oceanography, 11, 30-46.).

The Data Setup tab in the dialog box looks like this:

Example: For an interval of 10 db between scans, buoyancy window sizes of
5, 10, or 20 db result in a window size of three scans. Window sizes of 30 or
40 db result in a window size of five scans.

Note:
The input .cnv file for BUOYANCY
must have been processed with BIN
AVERAGE on pressure bins (with or
without interpolation) and must
contain pressure, temperature, and
either salinity or conductivity.

40 db window = 5 scans (10, 20, 30, 40, 50 db)

30 db window = 4 scans (10, 20, 30, 40 db) + 1 scan to make odd number

20 db window = 3 scans (10, 20, 30 db)

10 db window = 3 scan minimum

5 db window = 3 scan minimum

10 db 20 db 30 db 40 db 50 db

Select variable used in buoyancy computation:
•  Latitude - BUOYANCY uses algorithm in UNESCO

Technical Papers in Marine Science 44 to estimate
local gravity from user-input latitude

•  Gravity

Select buoyancy
variables to be
computed and added
to .cnv file - 1, 2, 3,
or 4 variables can be
computed.

Calculate buoyancy variables for pressure values
centered in window. BUOYANCY converts window
size from decibars to scans based on pressure
interval between scans in input file. If window size is
less than three scans, BUOYANCY sets it to three
scans. If window size is an even number of scans,
BUOYANCY adds one scan to window size. (see
example below)
Note:
As used here, a scan is one row of output data from
BIN AVERAGE, which is an average of many scans
of original data.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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BUOYANCY: Formulas
The relationship between frequency N and stability E is:

N 2 = gE    [rad2/s2]

where g = gravity [m / s2]

The algorithm used to compute N2 for the pressure value centered in the
buoyancy window is:

1. Compute averages:
p_bar = average pressure in the buoyancy window [decibars]
t_bar = average temperature in the buoyancy window [deg C]
s_bar = average salinity in the buoyancy window [PSU]
rho_bar = density (s_bar, t_bar, p_bar) [Kg / m3]

2. Compute the vertical gradient:
theta = potential temperature (s, t, p, p_bar)
v = 1 / density(s, theta, p_bar)
where s, t, and p are the averaged values for salinity, temperature, and
pressure calculated in BIN AVERAGE

Use a least squares fit to compute the linear gradient dv/dp in the
buoyancy window.

3. Compute N2, N, E, and 10 -8E:

N 2 = -1.0e-4 rho_bar 2 g 2                         [rad 2/s2]

N =                 √ N 2       [cycles/hour]

E =                          [rad 2/m]

E = 10 8                        [10 -8 rad 2/m]

BUOYANCY adds the following to the data file header:
Buoyancy_date Date and time that module was run.
Buoyancy_in Input .cnv file.
Buoyancy_vars Gravity value (input value or value based on input

latitude) and buoyancy window size (adjusted to provide
a minimum of three scans and an odd number of scans).

N 2

g

3600
2Π

N 2

g

δδδδνννν
δδδδp
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CELL THERMAL MASS
CELL THERMAL MASS uses a recursive filter to remove conductivity cell
thermal mass effects from the measured conductivity. In areas with steep
temperature gradients, the thermal mass correction is on the order of
0.005 PSU. In other areas the correction is negligible.

Typical values for alpha and 1/beta are:
Instrument alpha 1/beta
SBE 9plus with TC duct and 3000 rpm pump 0.03 7.0
SBE 25 with TC duct and 2000 rpm pump 0.04 8.0

The Data Setup tab in the dialog box looks like this:

CELL THERMAL MASS: Formulas
The algorithm used is:
dt = temperature - previous temperature
ctm = -1.0  * b * previous ctm + a * (dc/dt) * dt
corrected conductivity = c + ctm
where:
a = 2 * alpha / (sample interval * beta + 2)
b = 1 - (2 * a / alpha)
dc/dt = 0.1 * (1 + 0.006 * [temperature - 20])

To determine the values for alpha and beta, see:
Lueck, R.G., 1990: Thermal Inertia of Conductivity Cells: Theory., American
Meteorological Society Oct 1990, 741-755.

CELL THERMAL MASS adds the following to the data file header:
Celltm_date Date and time that module was run.
Celltm_in Input .cnv file.
Celltm_alpha Value used for alpha.
Celltm_tau Value used for 1/beta.
Celltm_temp_sensor
_use_for_cond

Temperature sensor for primary conductivity filter,
temperature sensor for secondary conductivity filter.

Filter primary and/or
secondary conductivity
values.

Use primary or secondary
temperature sensor data for
filtering the conductivity data.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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DERIVE
DERIVE uses pressure, temperature, and conductivity from the input .cnv file
to compute the following oceanographic parameters:
•  density (density, sigma-theta, sigma-t, sigma-1, sigma-2, sigma-4)
•  depth (salt water, fresh water)
•  dynamic meters
•  geopotential anomaly
•  potential temperature (reference pressure = 0.0 decibars)
•  potential temperature anomaly
•  salinity
•  sound velocity (Chen-Millero, DelGrosso, Wilson)
•  average sound velocity
•  specific volume anomaly
•  thermosteric anomaly
•  descent rate and acceleration (if input file has not been averaged into

pressure or depth bins)
•  oxygen (if input file contains pressure, temperature, and either

conductivity or salinity, and has not been averaged into pressure or
depth bins)

The Data Setup tab in the dialog box looks like this:

Note:
The File Setup tab for DERIVE
requires selection of both an input
data file and an instrument
configuration (.con) file before it will
process data. However, an
SBE 37-SM, 37-IM, 39, and 48
stores calibration coefficients
internally, and does not have a .con
file. For these and any other
instruments with internal calibration
coefficients, select any .con file (or
create and select an empty file with a
.con extension); the contents of the
file will not affect the results.

Select variables to
be calculated.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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The Select Derived Variables dialog box looks like this:

DERIVE: Formulas

General Information:
•  Temperature used for derived variables is IPTS-68.

Following the recommendation of JPOTS, T68 is assumed to be
1.00024 * T90 (-2 to 35 °C).

•  Salinity is PSS-78.
•  Density is calculated based on the equation of state for seawater (EOS80).

The formulas for the computation of salinity, density, potential temperature,
specific volume anomaly, and sound velocity were obtained from "Algorithms
for computation of fundamental properties of seawater", by N.P. Fofonoff and
R.C Millard Jr.; Unesco technical papers in marine science #44, 1983.

density = ρρρρ = ρρρρ (s, t, p)     [kg/m3]
(density of sea water with salinity s, temperature t, and pressure p)

Sigma-theta = σσσσ θθθθ = ρρρρ (s, θθθθ(s, t, p, 0), 0) - 1000    [kg/m 3]

Sigma-1 = σσσσ 1 = ρρρρ (s, θθθθ(s, t, p, 1000), 1000) - 1000     [kg/m 3]

Sigma-2 = σσσσ 2 = ρρρρ (s, θθθθ(s, t, p, 2000), 2000) - 1000     [kg/m 3]

Sigma-4 = σσσσ 4 = ρρρρ (s, θθθθ(s, t, p, 4000), 4000) - 1000     [kg/m 3]

Sigma-t = σσσσ t = ρρρρ (s, t, 0) - 1000     [kg/m 3]

potential temperature [IPTS-68] = θθθθ (s, t, p, pr)     [°°°° C]
potential temperature [ITS-90] = θθθθ (s, t, p, pr) / 1.00024     [°°°° C]
(Potential temperature is the temperature an element of seawater would have if
raised adiabatically with no change in salinity to reference pressure pr.
DATA CONVERSION, DERIVE, and SEACALC use a reference pressure of
0 decibars).

Note:
See DOS SEASOFT manual for
details on SEACALC - this module
is not yet available in the Windows
version of the software.

Click Data to view/modify user-input parameters for selected variable (if applicable).
Some variables share a user-input parameter, so changing the parameter for one
variable automatically changes it for the other:
•  Descent rate and acceleration use the same time window size
•  All oxygen sensors use the same time window size

•  Add variable: click blank field in
Variable Name column, click desired
sensor in sensor list, click Add.

•  Change variable: click existing sensor
in Variable Name column, click desired
sensor in sensor list, click Change.

•  Insert variable: click existing sensor
below desired sequence # in Variable
Name column, click desired sensor in
sensor list, click Insert.

If DERIVE requires additional information
to compute a variable, a dialog box
appears after variable is selected, with
fields for required user-input parameters.
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potential temperature anomaly =
     potential temperature - a0 - a1 x salinity
               or
     potential temperature - a0 - a1 x Sigma-theta
(a0, a1, and the selection of salinity or sigma-theta are user-input.)

thermosteric anomaly = 10 5 ((1000/(1000 + σσσσ t)) - 0.97266) [10 -8 m 3/kg]

specific volume = V(s, t, p) = 1/ρρρρ     [m 3/kg]

specific volume anomaly = δδδδ = 10 8 (V(s, t, p) - V(35, 0, p))     [10 -8 m 3/kg]

p=p

geopotential anomaly = 10-4  ΣΣΣΣ   (δδδδ x ∆∆∆∆p)     [J/kg] = [m 2/s 2 ]
∆∆∆∆p,p=0

dynamic meters = geopotential anomaly / 10.0
(1 dynamic meter = 10 J/kg;
(Sverdup, Johnson, Flemming (1946), UNESCO (1991)))

oxygen [µµµµmoles/kg] =                                          oxygen     [ml/l]

average sound velocity = [m/s]

(Average sound velocity is the average from the surface to the current CTD
depth. The average is calculated on the downcast only. The first window
begins when pressure is greater than the minimum specified pressure and
salinity is greater than the minimum specified salinity. The average is updated
when both the change in pressure and change in time are greater than the
respective specified window sizes. The average sound velocity within the
window is avgSV.)

Derivative variables (doc/dt, descent rate, and acceleration) are computed by
looking at data centered around the current data point with a time span equal to
window size and using a linear regression to determine the slope.

DERIVE adds the following to the data file header:
Derive_date Date and time that module was run.
Derive_in Input .cnv and .con files.
Derive_oxygen_coeff Soc, Boc, tcor, pcor, tau, wt
Derive_time_window_docdt Window size for oxygen doc/dt

calculation (seconds).
Derive_time_window_dzdt Window size for descent rate and acceleration

calculation (seconds).

Sigma - θθθθ + 1000

44.660

ΣΣΣΣ      (∆∆∆∆p x avgSV)
∆∆∆∆p,p=min

p=p

ΣΣΣΣ      ∆∆∆∆p
∆∆∆∆p,p=min

p=p

Surface

> Minimum specified pressure and salinity
>pressure and
time window

>pressure and
time window

Average sound
velocity

Average sound
velocity

avgSV

avgSV
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FILTER
FILTER runs a low-pass filter on one or more columns of data. A low-pass
filter smoothes high frequency (rapidly changing) data. To produce zero phase
(no time shift), the filter is first run forward through the data and then run
backwards through the data. This removes any delays caused by the filter.

Typically, only conductivity and pressure data are filtered. Two time constants
can be specified, so conductivity and pressure can be filtered with different
time constants in one run of FILTER. Typical time constants for the SBE 9 are
0.03 seconds for conductivity and 0.15 seconds for pressure.

The Data Setup tab in the dialog box looks like this:

The Specify Filters dialog box looks like this:

Select which variables to apply
filter to, and which time constant
to use for each variable.

Desired filter time constants

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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FILTER: Formulas
For a low-pass filter with time constant Γ:

Γ= 1/ω         ω = 2πf
T = sample interval (seconds)
S0 = 1/ Γ

Laplace transform of the transfer function of a low-pass filter (single pole)
with a time constant of Γ seconds is:

H(s) =

Using the bilinear transform:

S - f(z)  =                                 =

H(z) =                                       =

If:     a =                                             b =

Then:    H(z) =                       =

Where z -1 is the unit delay (one scan behind).

y[N] = current output
y[N-1] = previous output
x[N] = input data (current scan)
x[N-1] = previous input data (from previous scan)

Y(z) (1 + bz -1) = X(z) a (z -1 + 1)
y[N] + by[N-1] = ax[N-1] + ay[N-1]
y[N] = a(x[N] + x[N-1]) - by[N-1]

Example: Time constant = 0.5 second, sample interval = 1/24 second

A =                                 =                    = 0.04

B = (1 - 2 * 0.5 * 24) a =                     = -0.92

FILTER adds the following to the data file header:
Filter_date Date and time that module was run.
Filter_in Input .cnv file.
Filter_low_pass_tc_A Time constant for filter A.
Filter_low-Pass_tc_B Time constant for filter B.
Filter_low_pass_A_vars List of variables filtered with time constant A.
Filter_low_pass_B_vars List of variables filtered with time constant B.

1

1 + (S/S0)

2 (1-z -1)

T (1 + z -1)

2 (z - 1)

T (z +1)
Δ

          1

2 (z - 1)

T (z + 1) S0

1 +

   z -1 + 1

2

TS0

1 + {1 + (         ) z -1}1 - 2/TS0

1 + 2/TS0

1

2

TS0

1 +
2

TS0

1 +

2

TS0

1 -

a (z -1 +1)

(1 + bz -1)

Y(z )

X(z)

1

(1 + 2 * 0.5 * 24)

1

(1 + 24)

1 - 24

1 + 24
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LOOP EDIT
LOOP EDIT marks scans bad by setting the flag value associated with the
scan to badflag in input .cnv files that have pressure slowdowns or reversals.
The badflag value is documented in the input .cnv header.

The Data Setup tab in the dialog box looks like this:

LOOP EDIT adds the following to the data file header:
Loopedit_date Date and time that module was run.
Loopedit_in Input .cnv file.
Loopedit_minVelocity If Fixed Minimum Velocity was selected -

minimum CTD velocity for good scans;
scans with velocity less than this are marked
with badflag.

Loopedit_percentMeanSpeed If Percent of Mean Speed was selected -
minimum CTD velocity for first time
window, window size, and percent of mean
speed for good scans; scans that do not meet
this criteria are marked with badflag.

Loopedit_excl_bad_scans If yes, do not evaluate scans marked with
badflag in a previous run of LOOP EDIT.

•  If selected, scans previously
marked with badflag (for
example, in a previous run
of LOOP EDIT) will not
be evaluated.

•  If not selected, scans
previously marked with
badflag will be reevaluated,
and scan’s flag will be
reset accordingly.

Minimum velocity type:
•  Fixed minimum velocity - If CTD velocity is less

than specified Minimum CTD Velocity or
pressure is not greater than previous maximum
pressure, scan is marked with badflag.

•  Percent of mean speed - For each scan, mean
speed over last Window Size seconds is
computed. If CTD velocity is less than specified
Percent of Mean Speed, or if pressure is not
greater than previous maximum pressure, scan
is marked with badflag. Minimum CTD Velocity is
used to evaluate data points in first time window.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.
Begin processing data. Status
field on File Setup tab shows
Processing complete when done.
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WILD EDIT
WILD EDIT marks wild points in the data by replacing the data value with
badflag. The badflag value is documented in the input .cnv header. WILD
EDIT’s algorithm requires two passes through the data: the first pass obtains
an accurate estimate of the data’s true standard deviation, while the second
pass replaces the appropriate data with badflag.

The Data Setup tab in the dialog box looks like this:

If the data file is particularly corrupted, it may be necessary to run
WILD EDIT more than once, with different block sizes and number of
standard deviations.

WILD EDIT adds the following to the data file header:
Wildedit_date Date and time that module was run.
Wildedit_in Input .cnv file.
Wildedit_pass1_nstd Number of standard deviations for pass 1 test.
Wildedit_pass2_nstd Number of standard deviations for pass 2 test.
Wildedit_pass2_mindelta Keep data within this distance of mean.
Wildedit_npoint Number of points to include in each test.
Wildedit_vars List of the variables tested for wild points.
Wildedit_excl_bad_scans If yes, values in scans marked with badflag (in

LOOP EDIT) will not be used to determine
standard deviation.

Note:
WILD EDIT marks individual data
(for example, a conductivity value)
with badflag, but does not mark the
entire scan (which may include other
data that is valid, such as
temperature, pressure, etc.).

If selected, data from
scans marked with
badflag in LOOP EDIT
will not be used in
calculating mean and
standard deviation.

Select which variables
to run WILD EDIT on.

WILD EDIT operates
as follows:
1. Compute mean and

standard deviation of data in
block (specified by Scans
per Block) for each selected
variable. Temporarily flag
values that differ from mean
by more than standard
deviations specified for
pass 1.

2. Recompute mean and
standard deviation,
excluding temporarily
flagged values. Mark values
that differ from mean by
more than standard
deviations specified for
pass 2 by replacing data
value with badflag.

3. Repeat Steps 1 and 2 for
next block of scans.
•  If last block has less than

specified number of
scans, use data from
previous block to fill
in block.

Do not flag data within this distance of mean,
even if it falls outside specified standard
deviation. Typically, leave at 0. May need to use
if data is very quiet (for example, a single bit
change in voltage may cause data to fall outside
specified standard deviation and be marked bad).
A typical sequence for using parameter follows:
1. Run WILD EDIT for all desired variables, with

parameter set to 0.
2. Compare output to input data. If a variable’s

data points that are very close to mean were
set to badflag:
A. Rerun WILD EDIT for all other variables,

leaving parameter at 0 and overwriting
output file from Step 1.

B. Rerun WILD EDIT for quiet variable only,
setting parameter to desired value to
prevent flagging of data close to mean.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing
data. Status field on
File Setup tab shows
Processing complete
when done.
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WINDOW FILTER
WINDOW FILTER provides four types of window filters and a median filter
for data smoothing of .cnv files:
•  Window filters calculate a weighted average of data values about a center

point and replace the data value at the center point with this average.
•  The median filter calculates a median for data values about a center point

and replaces the data value at the center point with the median.

The Data Setup tab in the dialog box looks like this:

The Specify Window Filters dialog box looks like this:

Select none, boxcar, cosine,
gaussian, median, or triangle filter.
A dialog box appears to enter
applicable filter parameters, which
then display in Parameters column.

If selected, data
from scans marked
with badflag in
LOOP EDIT will not
be used.

Select which variables to run
WINDOW FILTER on, and
specify the filters.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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Window Filters: Descriptions and Formulas

Shape and length define filter windows:
•  WINDOW FILTER provides four window shapes: boxcar, cosine,

triangle, and gaussian.
•  The minimum window length is 1 scan, and the maximum is 511 scans.

Window length must be an odd number, so that the window has a center
point. If a window length is specified as an even number, WINDOW
FILTER automatically adds 1 to make the length odd.

The window filter calculates a weighted average of data values about a center
point, using the following transfer function:

L/2

y(n) =   Σ  w(k) x(n-k)
k=-L/2

The figure below shows the impulse response of each of the four filter types
for a filter of length 17 scans. The impulse response of a filter is obtained by
filtering a data set that has zeros everywhere except one data value that is set
to 1.
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The window filtering process is similar for all filter types:
1. Filter weights are calculated (see the equations below).
2. Filter weights are normalized to sum to 1.

•  When a bad data point is encountered (scan marked with badflag if
exclude scans marked bad was selected or data value marked with
badflag), the weights are renormalized, excluding the filter element
that would operate on the bad data point.

Boxcar Filter

w(n) = for n =   -   . .

Cosine Filter
w(n) = 1      for n = 0

w(n) = cos  for n =   -         . .-1, 1 . .

Triangle Filter

w(n) = 1      for n = 0

w(n) = for n =   -   . .-1, 1 . .

where K = + 1

Gaussian Filter

phase =

scale = log(2) x     2 x

w(n) = e -phase x phase x scale     for n = 0

w(n) = e -(n - phase)2  x scale   for n =  -                . .-1, 1 . .

The gaussian window has parameters of halfwidth (in scans) and offset (in
time), in addition to window length (in scans). These extra parameters allow
data to be filtered and shifted in time in one operation. Halfwidth determines
the width of the gaussian curve. A window length of 9 and halfwidth of 4
produces a set of filter weights that fills the window. A window length of 17
and halfwidth of 4 produces a set of filter weights that fills only half the
window. If the filter weights do not fill the window, the offset parameter may
be used to shift the weights within the window without clipping the edge of the
gaussian curve.

Note:
In the window filter equations:
•  L = window length in scans,

(always an odd number)
•  n = window index, -L/2 to +L/2,

with 0 the center point of
the window

•  w(n) = set of window weights

1

L

L - 1

2

L - 1

2

n x π

L + 1

L - 1

2

L - 1

2

|n|

K

L - 1

2

L - 1

2
L - 1

2

offset (sec)

sample interval (sec)
sample rate

half width (scans)( )
2

L - 1

2

L - 1

2
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Example: Window length is 33 scans and halfwidth is 4 scans. Offset is
-3 seconds in the left curve, 0 in the middle curve, and +3 seconds in the
right curve.

Note that the window length in the example is larger than the halfwidth. This
allows the complete gaussian curve to be expressed in the window when the
offset parameter shifts the curve forward or backward in time. If the halfwidth
was larger, the trailing edge of the -3 second offset curve would be truncated
and the leading edge of the +3 second curve would be truncated. The offset
parameter moves the gaussian shape of the window weights forward or
backward in time. Since the weighted average is calculated for a data value in
the center of the window, this has the effect of shifting the data that the filter is
operating on forward or backward in time relative to the other data in the file.
This capability allows filtering and time shifting to be done in one step.

Median Filter: Description
The median filter is not a smoothing filter in the same sense as the window
filters described above. Median filtering is most useful in spike removal.
A median value is determined for a specified window, and the data value at the
window’s center point is replaced by the median value.

WINDOW FILTER adds the following to the data file header:
Wfilter_date Date and time that module was run.
Wfilter_in Input .cnv file.
Wfilter_excl_
bad_scans

If yes, values in scans marked with badflag in LOOP EDIT
will not be used.

Wfilter_action Data channel identifier, filter type, filter parameters.
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Section 9: Data Display and Plotting
Modules

All display and plotting is performed on converted data from a .cnv file.

Module Name Module Description
ASCII OUT Output data portion and/or header portion from .cnv file

to an ASCII file (.asc for data, .hdr for header).
Useful for exporting converted data for processing by
other (non-Sea-Bird) software.

CONTOUR Generate density contours to overlay on TS plots. See
DOS SEASOFT manual for details - this module is not
yet available in the Windows version of the software.

SEAPLOT Plot data (C, T, P as well as derived variables). Plots can
be screen dumped to a printer or plotted on an HP pen
plotter or HP LaserJet III. Note that SEAPLOT can plot
data at any point after DATA CONVERSION has been
run. See DOS SEASOFT manual for details - this
module is not yet available in the Windows version of the
software.
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ASCII OUT
ASCII OUT outputs the header portion and/or the data portion of a converted
data file (.cnv).
•  The data portion is written in ASCII engineering units to a .asc file, and

may be useful if you are planning to export converted data for processing
by other (non-Sea-Bird) software.

•  The header portion is written to a .hdr file.

The Data Setup tab in the dialog box looks like this:

ASCII OUT does not add anything to the data file header. The output header
(.hdr) file contains the header from the input (.cnv) file.

If selected, scans
marked with badflag in
LOOP EDIT will not be
output in data file.

Column label for output data file: Top of the file,
Top of each page, or No column labels.

If columns are labeled at top of each page,
form feed character is inserted after selected
number of lines/page.

If selected, all occurrences of badflag in input file (occurrences in flag
column as well as in data columns) are replaced with specified value
in output file. This may be useful for plotting purposes, as SBE Data
Processing uses a very small number (-9.990e-29) for badflag, which
looks like 0 in a plot.

Column separator for output data file:
space, tab, semi-colon, or colon.

Date format for output data file
(applicable if date selected as an
output variable)

Select which variables to
include in output data file.

If selected, a column is
inserted before the first
column of data, with
specified column name
and data value.

Return to SBE Data Processing window.
•  If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.
•  If Confirm Program Setup Change was not selected in Options menu - This button

says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.
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Appendix I: Run Options, Command Line
Operation, and Batch File Processing
SBE Data Processing Run Options

Run options can be used to assist in automating processing, by overriding
information in an existing program setup (.psu) file or designating a different
.psu file.

Access the Run Options dialog box by clicking Run Options in the
SBE Data Processing window:

The Run Options dialog box looks like this:

Note:
The default program setup (.psu)
file is the last saved .psu file for
the module. PostProcSuite.ini,
located in the Windows directory,
contains the location and file name
of the last saved .psu file for
each module.
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The option parameters are:
Parameter Description
/cString Use String as instrument configuration (.con) file. String must

include full path and file name. Note: If using this parameter,
you must also specify input file name (using  /iString).

/iString Use String as input file name. String must include full path and
file name.
The /iString option supports standard wildcard expansion:
•  ? matches any single character in specified position within

file name or extension
•  * matches any set of characters starting at specified position

within file name or extension and continuing until end of file
name or extension or another specified character

/oString Use String as output directory (not including file name).
/fString Use String as output file name (not including directory).
/aString Append String to output file name (before file name extension).
/pString Use String as Program Setup (.psu) file. String must include full

path and file name.
If specifying multiple parameters, insert a space between each parameter
in the list.

Example: You set up and saved .psu files for FILTER, LOOP EDIT, BIN
AVERAGE, and DERIVE within each module’s dialog box, and ran each
module successively. The input and output file names in all the .psu files were
the same - c:/1st/test.cnv (this has the effect of overwriting the module input
with the module output).
You now want to run each process again, using a different input and output
file - c:\2nd\test1.cnv. You enter the following in SBE Data Processing’s
Run Options dialog box:

/ic:\2nd\test1.cnv  /ftest1.cnv  /oc:\2nd

When you pull down on the Run menu and select FILTER, you see in the
FILTER dialog box that the program substituted c:\2nd\test1.cnv for
c:\1st\test.cnv as the input data and output data path and file. Similarly,
test1.cnv is shown as the input and output data file in all the modules. You can
run each process rapidly in succession, without having to enter the new path
and file name individually in each module.

Auto Start (for running a post-processing module)
Select this and then select the desired post-processing module to have
SBE Data Processing automatically run the module with the last saved setup
parameters (defined by the .psu file) and any entered Run Options.
•  If you select Auto Start, a Run Minimized selection box appears. If

selected, SBE Data Processing minimizes its window while processing the
data, allowing you to do other work on the computer. When processing is
complete, the SBE Data Processing window reappears.

Note:
If you do not select Auto Start,
when you select a module the
module dialog box appears,
allowing you to review the selected
input files and data setup before
beginning processing.
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Command Line Operation
The following modules can be run from the command line (default location for
all files listed below is c:/Program Files/Sea-Bird/DataProcessing-Win32):

Module Executable File Name
ALIGN CTD AlignCTDW.exe

ASCII IN ASCII_InW.exe
ASCII OUT ASCII_OutW.exe

BIN AVERAGE BinAvgW.exe
BUOYANCY BuoyancyW.exe

CELL THERMAL MASS CellTMW.exe
DATA CONVERSION DatCnvW.exe

DERIVE DeriveW.exe
FILTER FilterW.exe

LOOP EDIT LoopEditW.exe
MARK SCAN MarkScanW.exe

ROSETTE SUMMARY RosSumW.exe
SECTION SectionW.exe

SPLIT SplitW.exe
STRIP StripW.exe

TRANSLATE TransW.exe
WILD EDIT WildEditW.exe

WINDOW FILTER W_FilterW.exe

Command line parameters can be used to override existing information in the
.psu file. The command line parameters are:
Parameter Description
/cString Use String as instrument configuration (.con) file. String must

include full path and file name. Note: If using this parameter, you
must also specify input file name (using  /iString).

/iString Use String as input file name. String must include full path and
file name.
This parameter supports standard wildcard expansion:
•  ? matches any single character in specified position within

file name or extension
•  * matches any set of characters starting at specified position

within file name or extension and continuing until end of file
name or extension or another specified character

/oString Use String as output directory (not including file name).
/fString Use String as output file name (not including directory).
/aString Append String to output file name (before file name extension).
/pString Use String as Program Setup (.psu) file. String must include full

path and file name.
/s Start processing now.
If specifying multiple parameters, insert a space between each parameter
in the list.

Example: The specified input file directory contains test.dat, test1.dat, and
test2.dat. Select Run in the Windows Start menu. The Run dialog box appears.

For the command line shown (datcnvw.exe  /itest*.dat  /s), SBE Data
Processing will process test.dat, test1.dat, and test2.dat using DATA
CONVERSION. If the ? wildcard symbol is used (datcnvw /itest?.dat) instead
of the *, DATA CONVERSION will process only test1.dat and test2.dat.

Note:
The default program setup (.psu)
file, used when running a module
from the command line, is the last
saved .psu file for the module.
PostProcSuite.ini, located
in the Windows directory, contains
a list of the location and file name
of the last saved .psu file for
each module.

Note:
If you have not modified your
autoexec.bat file to put the .exe
files in the path statement, specify
the full path of datcnvw.exe in the
Run dialog box.
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Batch File Processing
Traditional DOS batch file processing cannot be used with the 32-bit post-
processing modules because Win 95/98/NT will start the second process
before the first process is finished. The program SBEBatch.exe (default
location c:/Program Files/Sea-Bird/DataProcessing-Win32) or the Windows
Scripting Host can be used to process a batch file to automate data processing
tasks. The format for SBEBatch is:

sbebatch filename parameters

The parameters are referenced in the batch file in the same way as the DOS
batch file, using the percent sign (%) followed by numbers 1 through 9. %1 in
the batch file is replaced by the first command line parameter, %2 in the batch
file is replaced by the second command line parameter, and so on until %9.

Each line in the batch file contains the process name followed by command
line arguments. The process names are:

Module Process Name
ALIGN CTD AlignCTD

ASCII IN ASCIIIn
ASCII OUT ASCIIOut

BIN AVERAGE BinAvg
BUOYANCY Buoyancy

CELL THERMAL MASS CellTM
DATA CONVERSION DatCnv

DERIVE Derive
FILTER Filter

LOOP EDIT LoopEdit
MARK SCAN MarkScan

ROSETTE SUMMARY RosSum
SECTION Section

SPLIT Split
STRIP Strip

TRANSLATE Trans
WILD EDIT WildEdit

WINDOW FILTER WFilter

Parameters specified in the batch file can be used to override existing
information in the .psu file. These parameters are:
Parameter Description
/cString Use String as instrument configuration (.con) file. String must

include full path and file name. Note: If using this parameter, you
must also specify input file name (using  /iString).

/iString Use String as input file name. String must include full path and
file name.
The /iString parameter supports standard wildcard expansion:
•  ? matches any single character in specified position within

file name or extension
•  * matches any set of characters starting at specified position

within file name or extension and continuing until the end of
file name or extension or another specified character

/oString Use String as output directory (not including file name).
/fString Use String as output file name (not including directory).
/aString Append String to output file name (before file name extension).
/pString Use String as Program Setup (.psu) file. String must include full

path and file name.
#m Minimize the SBE Data Processing window while processing the

data, allowing you to do other work on the computer.
If specifying multiple parameters, insert a space between each parameter
in the list.

Note:
The default program setup (.psu)
file, used when running a module
from the command line, is the last
saved .psu file for the module.
PostProcSuite.ini, located in the
Windows directory, contains a list
of the location and file name of
the last saved .psu file for
each module.

Note:
If you have not modified your
autoexec.bat file to put
sbebatch.exe in the path statement,
specify the full path of sbebatch.exe
in the Run dialog box.
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To process data using a batch file:
1. Run each software module, entering the desired choices in the File Setup

and Data Setup dialog boxes. Upon completing both dialog boxes, press
Save or Save As in the File Setup dialog box. The configuration is stored
in the Program Setup File (.psu).

2. Create a batch file to process the data.

Following are two examples of typical batch files.

Example 1 – Process Single File, and Save All Intermediate Files
The data file is c:\leg1\cast5.dat, and the .con file is c:\leg1\cast5.con.
1. Set up each software module, entering desired choices in Data Setup

dialog boxes. In the File Setup dialog boxes, delete the output file name
(this allows program to base output file name on input file name and any
appended text), and set the output file path as c:\leg1.

2. Create a batch file named prcast.txt in c:\leg1, which contains:
datcnv  /ic:\leg1\%1.dat  /cc:\leg1\%1.con  /a%2
wildedit  /ic:\leg1\%1%2.cnv  /as1
filter  /ic:\leg1\%1%2s1.cnv  /as2
loopedit  /ic:\leg1\%1%2s1s2.cnv  /as3
derive  /i%c:\leg1\1%2s1s2s3.cnv  /cc:\leg1\%1.con  /as4

3. Select Run in the Windows Start menu. The Run dialog box appears.
4. Type in the program name and parameters as shown:

sbebatch  c:\leg1\prcast.txt  cast5  test1
(batch filename is c:\leg1\prcast1.txt; parameter %1 is cast5;
parameter %2 is test1)

The data is processed as follows (all input and output files are in c:\leg1):
Module Input File(s) Output File

DATA CONVERSION
(datcnv)

cast5.dat
cast5.con

cast5test1.cnv

WILD EDIT (wildedit) cast5test1.cnv cast5test1s1.cnv
FILTER (filter) cast5test1s1.cnv cast5test1s1s2.cnv

LOOP EDIT (loopedit) cast5test1s1s2.cnv cast5test1s1s2s3.cnv
DERIVE (derive) cast5test1s1s2s3.cnv

cast5.con
cast5test1s1s2s3s4.cnv
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Example 2 – Process Several Files, and Overwrite All Intermediate Files
Process all data files in c:\leg1. The data files are c:\leg1\cast1.dat and
c:\leg1\cast2.dat, and the .con file is c:\leg1\cast.con.
1. Set up each software module, entering desired choices in Data Setup

dialog boxes. In the File Setup dialog boxes, delete the output file name
(this allows program to base output file name on input file name and any
appended text). Set the output file path as c:\leg1.

2. Create a batch file named prallcasts.txt in c:\leg1, which contains:
datcnv  /i%1\*.dat  /c%1\cast.con  /o%1
wildedit  /i%1\*.cnv  /o1%
filter  /i%1\*.cnv  /o1%
loopedit  /i%1\*.cnv  /o1%
binavg  /i%1\*.cnv  /aavg  /o%1
derive  /i%1\*avg.cnv  /c%1\cast.con  /o%1

3. Select Run in the Windows Start menu. The Run dialog box appears.
4. Type in the program name and parameters as shown:

sbebatch  c:\leg1\prallcasts.txt  c:\leg1
(batch filename is c:\leg1\prallcasts.txt; parameter %1 is c:\leg1)

The data is processed as follows (all input and output files are in c:\leg1):
Module Input File(s) Output File

DATA CONVERSION (datcnv) cast1.dat
cast2.dat
cast.con

cast1.cnv
cast2.cnv

WILD EDIT (wildedit) cast1.cnv
cast2.cnv

cast1.cnv
cast2.cnv

FILTER (filter) cast1.cnv
cast2.cnv

cast1.cnv
cast2.cnv

LOOP EDIT (loopedit) cast1.cnv
cast2.cnv

cast1.cnv
cast2.cnv

BIN AVERAGE (binavg) cast1.cnv
cast2.cnv

cast1avg.cnv
cast2avg.cnv

DERIVE (derive) cast1avg.cnv
cast2avg.cnv
cast.con

cast1.cnv
cast2.cnv
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Appendix II: Configure File Format
Shown below is a line-by-line description of the .con file contents, which can
be viewed in a text editor.

Line Contents
1 conductivity sensor serial number
2 conductivity M, A, B, C, D, CPCOR
3 conductivity cell_const, series_r, slope, offset, use GHIJ coefficients?
4 temperature sensor serial number
5 temperature F0, A, B, C, D, slope, offset, use GHIJ coefficients?
6 secondary conductivity sensor serial number
7 secondary conductivity M, A, B, C, D, PCOR
8 secondary conductivity cell_const, series_r, slope, offset, use GHIJ coefficients?
9 secondary temperature sensor serial number
10 secondary temperature F0, A, B, C, D, slope, offset, use GHIJ coefficients?
11 pressure sensor serial number
12 pressure T1, T2, T3, T4, T5
13 pressure C1 (A1), C2 (A0), C3, C4 (A2) - parameters in parentheses for strain gauge sensor
14 pressure D1, D2, slope, offset, pressure sensor type, AD590_M, AD590_B
15 Oxygen (Beckman/YSI type) sensor serial number
16 Oxygen (Beckman/YSI type) M, B, K, C, SOC, TCOR
17 Oxygen (Beckman/YSI type) WT, PCOR, TAU, BOC
18 pH sensor serial number
19 pH slope, offset, VREF
20 PAR light sensor serial number
21 PAR cal const, multiplier, M, B, surface_cc, surface_r
22 transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) sensor serial number
23 transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) M, B, path length
24 fluorometer SeaTech sensor serial number
25 fluorometer SeaTech scale factor, offset
26 tilt sensor serial number
27 tilt XM, XB, YM, YB
28 ORP sensor serial number
29 ORP M, B, offset
30 OBS/Nephelometer D&A Backscatterance sensor serial number
31 OBS/Nephelometer D&A Backscatterance gain, offset
32 Altimeter scale factor, offset, hyst, min pressure, hysteresis
33 microstructure temperature sensor serial number
34 microstructure temperature pre_m, pre_b
35 microstructure temperature num, denom, A0, A1, A3
36 microstructure conductivity sensor serial number
37 microstructure conductivity A0, A1, A2
38 microstructure conductivity M, B, R
39 number of external frequencies, number of bytes, number of voltages, instrument type, computer

interface, scan rate, interval, store system time?
40 data format channels 0 - 9
41 data format channels 10 - 19
42 data format channels 20 - 39
43 sbe16: use water temperature?, fixed pressure, fixed pressure temperature
44 firmware version
45 sbe911plus: number of frequencies from sbe9, number of frequencies to be suppressed, number of

voltages to be suppressed, voltage range, add surface PAR voltage?, NMEA interface installed?,
include IOW sensors?

46 OBS/Nephelometer IFREMER sensor serial number
47 OBS/Nephelometer IFREMER VM0, VD0, D0, K
48 OBS/Nephelometer Chelsea sensor serial number
49 OBS/Nephelometer Chelsea clear water voltage, scale factor
50 ZAPS sensor serial number
51 ZAPS m, b
52 calibration date for conductivity sensor
53 calibration date for temperature sensor
54 calibration date for secondary conductivity sensor
55 calibration date for secondary temperature sensor
56 calibration date for pressure sensor
57 calibration date for oxygen (Beckman/YSI type) sensor
58 calibration date for pH sensor
59 calibration date for PAR light sensor
60 calibration date for transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar)  sensor
61 calibration date for fluorometer (SeaTech) sensor
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62 calibration date for tilt sensor
63 calibration date for ORP sensor
64 calibration date for OBS/Nephelometer D&A Backscatterance sensor
65 calibration date for microstructure temperature sensor
66 calibration date for microstructure conductivity sensor
67 calibration date for IFREMER OBS/nephelometer sensor
68 calibration date for Chelsea OBS/nephelometer sensor
69 calibration date for ZAPS sensor
70 secondary oxygen (Beckman/YSI type) sensor serial number
71 calibration date for secondary oxygen (Beckman/YSI type) sensor
72 secondary oxygen(Beckman/YSI type) M, B, K, C, SOC, TCOR
73 Secondary oxygen(Beckman/YSI type) WT, PCOR, TAU, BOC
74 User polynomial 1 sensor serial number
75 calibration date for user polynomial 1 sensor
76 User poly1 A0, A1, A2, A3
77 User polynomial 2 sensor serial number
78 Calibration date for user polynomial 2 sensor
79 User polynomial 2 A0, A1, A2, A3
80 User polynomial 3 sensor serial number
81 Calibration date for user polynomial 3 sensor
82 User polynomial 3 A0, A1, A2, A3
83 Dr. Haardt Chlorophyll fluorometer sensor serial number
84 Calibration date for Dr. Haardt Chlorophyll fluorometer sensor
85 Dr. Haardt Chlorophyll fluorometer A0, A1, B0, B1, which modulo bit, gain range switching
86 Dr. Haardt Phycoerythrin fluorometer sensor serial number
87 calibration date for Dr. Haardt Phycoerythrin fluorometer sensor
88 Dr. Haardt Phycoerythrin fluorometer A0, A1, B0, B1, which modulo bit, gain range switching
89 Dr. Haardt Turbidity OBS/nephelometer sensor serial number
90 calibration date for Dr. Haardt Turbidity OBS/nephelometer sensor
91 Dr. Haardt Turbidity OBS/nephelometer A0, A1, B0, B1, which modulo bit, gain range switching
92 IOW oxygen sensor serial number
93 calibration date for IOW oxygen sensor
94 IOW oxygen A0, A1, A2, A3, B0, B1
95 IOW sound velocity sensor serial number
96 calibration date for IOW sound velocity sensor
97 IOW sound velocity A0, A1, A2
98 biospherical natural fluorometer sensor serial number
99 calibration date for biospherical natural fluorometer sensor
100 biospherical natural fluorometer Cfn, A1, A2, B
101 sea tech ls6000 OBS/nephelometer sensor serial number
102 calibration date for sea tech ls6000 OBS/nephelometer sensor
103 sea tech ls6000 OBS/nephelometer gain, slope, offset
104 fluorometer chelsea Aquatracka sensor serial number
105 calibration date for fluorometer chelsea Aquatracka sensor
106 fluorometer chelsea Aquatracka scale factor, slope, offset, Vacetone, VB (static), V1ug/l
107 fluorometer turner sensor serial number
108 calibration date for fluorometer turner sensor
109 fluorometer turner scale factor, offset; or

turner-10au-005 full scale concentration, full scale voltage, zero point concentration
110 conductivity G, H, I, J, ctcor, cpcor
111 temperature F1, G, H, I, J
112 secondary conductivity G, H, I, J, ctcor, cpcor
113 secondary temperature F1, G, H, I, J
114 WET Labs AC3 beam transmission transmissometer sensor serial number.
115 calibration date for WET Labs AC3 beam transmission transmissometer sensor.
116 WET Labs AC3 beam transmission transmissometer Ch2o, Vh2o, Vdark, x, chlorophyll absorption

Kv, Vh2o, a^x.
117 WET Labs WETStar fluorometer sensor serial number.
118 calibration date for WET Labs WETStar fluorometer sensor.
119 WET Labs WETStar Vblank, scale factor.
120 calibration date for primary conductivity sensor using g, h, i, j coefficients.
121 calibration date for primary temperature sensor using g, h, i, j coefficients.
122 calibration date for secondary conductivity sensor using g, h, i, j coefficients.
123 calibration date for secondary temperature sensor using g, h, i, j coefficients.
124 FGP pressure sensor #0 serial number
125 calibration date for FGP pressure sensor #0
126 FGP pressure sensor #0 scale factor, offset
127 FGP pressure sensor #1 serial number
128 calibration date for FGP pressure sensor #1
129 FGP pressure sensor #1 scale factor, offset
130 FGP pressure sensor #2 serial number
131 calibration date for FGP pressure sensor #2
132 FGP pressure sensor #2 scale factor, offset
133 FGP pressure sensor #3 serial number
134 calibration date for FGP pressure sensor #3
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135 FGP pressure sensor #3 scale factor, offset
136 FGP pressure sensor #4 serial number
137 calibration date for FGP pressure sensor #4
138 FGP pressure sensor #4 scale factor, offset
139 FGP pressure sensor #5 serial number
140 calibration date for FGP pressure sensor #5
141 FGP pressure sensor #5 scale factor, offset
142 FGP pressure sensor #6 serial number
143 calibration date for FGP pressure sensor #6
144 FGP pressure sensor #6 scale factor, offset
145 FGP pressure sensor #7 serial number
146 calibration date for FGP pressure sensor #7
147 FGP pressure sensor #7 scale factor, offset
148 OBS/Nephelometer seapoint turbidity meter sensor serial number
149 calibration date for OBS/Nephelometer seapoint turbidity meter sensor
150 primary OBS/Nephelometer seapoint turbidity meter gain, scale
151 secondary OBS/Nephelometer seapoint turbidity meter sensor serial number
152 calibration date for secondary OBS/Nephelometer seapoint turbidity meter sensor
153 secondary OBS/Nephelometer seapoint turbidity meter gain, scale
154 Fluorometer Dr. Haardt Yellow Substance sensor serial number
155 calibration date for fluorometer Dr. Haardt Yellow Substance sensor
156 Fluorometer Dr. Haardt Yellow Substance A0, A1, B0, B1, which modulo bit, gain range switching
157 Fluorometer Chelsea Minitraka serial number
158 Fluorometer Chelsea Minitraka calibration date
159 Fluorometer Chelsea Minitraka vacetone, vacetone100, offset
160 Seapoint fluorometer serial number
161 Seapoint fluorometer calibration date
162 Seapoint fluorometer gain, offset
163 Sea-Bird Oxygen, primary, serial number
164 Sea-Bird Oxygen, primary, calibration date
165 Sea-Bird Oxygen, primary, Soc, Tcor
166 Sea-Bird Oxygen, primary, Pcor, Tau, Boc
167 Sea-Bird Oxygen, secondary, serial number
168 Sea-Bird Oxygen, secondary, calibration date
169 Sea-Bird Oxygen, secondary, Soc, Tcor
170 Sea-Bird Oxygen, secondary, Pcor, Tau, Boc
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Appendix III: Software Problems
Considerable effort has been made to test and check this software before its
release. However, because of the wide range of instruments that Sea-Bird
produces (and interfaces with) and the many applications that these
instruments are used in, there may be software problems that have not been
discovered and corrected. If a problem occurs, please contact us via phone
(425-643-0674), email (seabird@seabird.com), or fax (425-643-9954) with the
following information:

•  Instrument serial number
•  Version of the software originally shipped with the instrument
•  Version of the software you are attempting to run
•  Complete description of the problem you are having

If the problem involves the configuration or setup of the software, in most
cases a phone call to Sea-Bird will be sufficient to solve the problem. If you
phone, we would appreciate it if you would be ready to run the software
during the phone conversation.

If the problem involves data processing, you may be asked to send a sample of
the data to Sea-Bird for evaluation.
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Transmissometer · 39
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Voltage Sensors · 34
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CELL THERMAL MASS · 65
Command Line Operation · 81
CONFIGURE · 25

Calibration Coefficients - Frequency Sensors · 31
Calibration Coefficients - Voltage Sensors · 34
SBE 16 · 27
SBE 19 · 28
SBE 21 · 29
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DATA CONVERSION · 42
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File Extensions · 13
File Formats · 13
FILTER · 69
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Header View tab · 11
Installation · 8
LOOP EDIT · 71
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Problems · 88
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SPLIT · 53
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WILD EDIT · 72
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